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OVERVIEW

The Altera SoC combines a Hard Processing System (HPS) and an FPGA on a single device. The HPS has dual core ARM Cortex-
A9 MPUs and a host of peripherals such as DDR3 controllers, Ethernet MACs, SPI controllers and many more. The FPGA
portion of the device is tightly coupled through high performance bridges to the HPS. The designer can add peripherals they
create or from third party IP to the FPGA and map it into the HPS. Thus you have a flexible and very powerful solution.

This hardware lab provides an answer to following questions that a hardware developer might have:

How do | build a complete customized HPS SoC system?

How do | create a HPS in Qsys to realize a custom ARM SoC system with bridges to the FPGA?

How do | configure the HPS in Qsys to realize a unique set of HPS peripherals for a custom SoC system?

How do | use standard Qsys components to create a customized set of FPGA peripherals for my SoC system?
How do | use System Console to verify the peripherals in my SoC system are working properly?

How do | use ModelSIM to simulate and therefore validate the peripherals in my SoC system?

The HPS is configured using Qsys, Altera's SOC/FPGA IP integration tool. Configuration includes selecting DDR memory,
determining clock frequencies and selecting which HPS peripherals your design will use. As such Qsys inherently has most of
the information to satisfy the questions asked above. Qsys is also used to define the HPS peripheral pin outs and Quartus is
used to define the FPGA peripheral pin outs.

These two Altera FPGA development tools will generate the files needed for the transfer of design information from the
hardware to the software domain. A portion of the hardware modules will create a set of handoff files that are required to
build a preloader, a system register set (including FPGA registers) and the files required to create a Device Tree that will
support any operating system. For instance, the .socpinfo file will be used by the software designer to create a Device Tree
which will in turn be utilized to provide an interface for the Device Drivers in Linux or other operating system.

Qsys creates the files required for Hardware to Software domain transfer:

The diagram below shows three main areas of transfer from the hardware to software domains.
1. The files necessary to create a custom preloader

2. The .svd file that describes the FPGA peripherals and is used by the DS-5 register function

SoCKit HW Lab Instructions, Version 14.0 3

N\OW AGERA, LY LNEAR Five Years Out



OVERVIEW

3. The sopcinfo file that describes all of the HPS devices selected in Qsys and also those custom peripherals added in the
FPGA. These are used to build a device tree. The device tree is used by the Linux kernel to determine which device drivers to

load at boot time.

Handoff
files
0 =
Preloader
Generator reloader
DS-5
Debugger
i 0 e
DeviceTree .
Generator Device Tree
For 0
<, S SoC EDS H o
“ O=C

Hardware Module Summary:

The Hardware labs are based on completing the Golden Hardware Reference Design (GHRD) that is provided with the SoCKit.
You will examine the architecture of the GHRD in Module 2.

In Module 3 you will learn how use Quartus Il to create a Quartus Il project. In Module 4 you will utilize Qsys to build your HPS
based SoC system complete with a set of HPS peripherals to interface to the peripherals on the SoCKit. Next, you will create a
custom set of FPGA peripherals to interface to the HPS that also interface to peripherals on the SoCKit.

In Module 5 you will see how to complete the Quartus Il project to include pin assignments and timing constraints for the HPS
and FPGA peripherals that were instantiated in Qsys.

In Module 6 you will see how to validate the peripherals created in the FPGA using system console.

Module 7 is a bonus lab that shows how to utilize ModelSIM for Hardware validation of the FPGA peripherals that were
created in Qsys.

SoCKit HW Lab Instructions, Version 14.1 4
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Goal of this Hardware Lab:

The goal of this hardware lab is to customize the SoC hard processor system ( HPS) and build custom peripherals that will be
integrated with the HPS. Altera's SoC has the flexibility and customizability of adding additional peripherals to the FPGA by
using Qsys.

The SoC and the custom peripherals will in turn be used by the software lab where the peripherals will be accessible by the
Linux system.

This lab teaches you how to customize the HPS and peripherals. As the lab progresses, you will see how quick and easy it is to
build entire systems using Altera's system integration tool, Qsys, to configure and integrate pre-verified IP blocks.

Caution:

Do not continue until you have read the following:
The names that the lab document directs you to choose for files, components, and other objects in this exercise must be
spelled exactly as directed.

SoCKit HW Lab Instructions, Version 14.1 5
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Getting Started

MODULE 1. Getting Started

Your first objective is to ensure that you have all of the items needed and to install the tools so that you are ready to create
and run your design.

List of Required ltems:

e Arrow Electronics SoCKit development board
e Quartus Il v14.1 Web Edition

e  Computer with Windows 7, 4 GB RAM, minimum of 13 core and over 10 GB free hard disk space for the Quartus Il
install

e Lab Design Files

1.1 Acquiring Cyclone V SoCKit

To order a SoCKit please click on the link below

Order an SoCKit from Arrow Electronics

SoCKit HW Lab Instructions, Version 14.1 6
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Getting Started

1.2 Install the Altera Design Software

You will need to install the following design software package:

e Quartus Il Web Edition design software v14.1. — FPGA synthesis and compilation tool that contains QSys and
the MegaCore IP library with the SoC processor

The following steps will guide you through the installation instructions. Quartus Il Web Edition can be downloaded from the

Altera web site. Please carefully follow the steps shown below.

e Goto the Altera Download web page at https://www.altera.com/download/dnl-index.jsp

Download Center

Home > Support > Downloads >

Latest Release: Quartus II Version |[14.1

Which version of the Quartus 1T software supports my device? e

- - Related Links
Quartus IT Subscription Edition » Download _

Paid license required

(—— The industry's #1 design software What's MNew |
r-t =ff i performance and productivity.
i;?jma:s Free 30 day trial Compare Quartus IT Web

and Subscription Edition

Quartus IT Web Edition -
FREE, no license required » Download Compare ModelSim-Altera

A FREE version of Quartus@II and ModelSim-Altera Starter
software for vour CPLD and

. . Editi
selected medium-density and low- rhen
cost FPGA devices.

IP available for purchase L TR are

o Select "Quartus Il Web Package 14.1. Press the Free Web Package button.

SoCKit HW Lab Instructions, Version 14.1 7
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e Select Quartus Il Web Edition, Windows:
" HYH H ”
e Select the “Individual Files” Tab
" H ”
e Select the “ Download Selected Files” Button
e Download the Quartus Il software files onto your computer.
Release date: December, 2014
Latest Release: vid.1
Select release: | 14.1 v
]
Operating Svsteme L) ”’ Windows 6 Linux
Download Method 6 ®) skamai DLM3 Download Manager 6 Direct Download
‘, The Quartus II software version 14.1 supports the following device families: Arria 1I, Cyclone IV, Cyclone ¥
MAX II, MAX W, MAX 10 FPGA. More
| !
Combined Files Individual Files m Additional Software m
Download and install instructions: More
Read Altera Software v14.1 Installation FAQ
Quick Start Guide
W select All
[¥]Quartus II Web Edition (Free)
[¥]Quartus IT Software (includes Nios II EDS) o
Size: 1.2 GB MDS5: FB732633ECB57BE1A7 184 UPDATE
[v]ModelSim-Altera Edition (includes Starter Edition)
Size: 1.1 GB MD5: C93 F7F9B4306DDBEB248607993C7C
[l Devices
You must install device support for at least one device family to use the Quartus II software.
[[]Arria II device support
Size: 497.7 MB MD5: B329C8FCC2E1315B0E36C11ADA1A23F7
[[]Cyclone IV device support
Size: 462.7 MB MD5: 599819EBE4DDBEFAOBG22505B22432E86
[w]Cyclone V device support
Size: 1.0 GB MD5: 446D7EE5999226CD3294FB90A12C53CC
[[IMAX IT, MAX V device support
Size: 11.3 MB MD5: C3EDC556AC9770DB2DD63706EECA2654
[[IMAX 10 FPGA device support
Size: 285.0 MB MD5: 75F2D4AF1EB47FC53ACE6B619A35BD2CF
T
Download Selected Files
°

Login to myAltera account. Use your existing login, or Create Your myAltera account.

myAltera Account Sign In

Home >
User Name
Forgot Your User Name or Password?
Password
Remember me
Don’t have an account?
) Create Your myAltera Account

Your my#Altera account allows you to file a service request, register for a class, download software, and

maore.

Enter your email address.

(1F yo

il address already exists in our system we will retrieve the associated information.)

SoCKit HW Lab Instructions, Version 14.1 8
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Select a download folder (Make New Folder for v14.1)

~
Browse For Folder M

Please select a download folder

. HP50G_Manual &
f . LtcDc580PmbusDriver 1
> L Microtronix
, QI_131_practice
> QIVI31 |
> )L QUVI3 1 WE E
;) QI V14 0
, QI_V14 WE
o Sl STechnolonies i
[ Make New Folder ] [ OK ] [ Cancel ]

The files will then be downloaded via the Download Manager
Akamai DLM3 Download Manager: 7 files in total.

The files you selected are being downloaded to the directory you chose. You can pause and resume the
download at any time. If the download manager does not download any of the files, you can manually

download the files with the direct links in the list below.
Show direct links

Download In Progress. ( 1 of 7 files )

Total Download Size = 4.61GB Download Speed = 768.9KBps
Remaining Size = 4.57GB Estimated Time Remaining = 1h, 43m

Download Location = C:/Temp/QII_vi4.1WE

Downloading bundle
Total Progress 71.87%
QuartusSetupWeb-14.1.0.186-windows.exe (6 of 7): 3.06%

| 0

After the file is downloaded on the computer, select the *.exe file, and install the software.

€5 Installing Quartus T Web Edition (Free) 14.1.0.186 =2 Ech <=

Setup - Quartus II Web Edition (Free) 14.1.0.186

Welcome to the Quartus II Web Edition (Free) 14,1.0. 185 Setup Wizard.

For more information about Altera software, go to http:/fwww.altera.com.

SoCKit HW Lab Instructions, Version 14.1
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Getting Started

o Accept the license agreement, then “Next >”.
€4 Installing Quartus Il Web Edition (Free) 14.1.0.186 =n =R =T

—
License Agreement m
®

‘You can view the full license agreement at the link below or use —install_lic option from command-ine to get the license agreement
files before the installation. You must accept the terms of the agreement before continuing with the installation.

http: {/dl.altera.com/eula

QUARTUS(R) II LICENSE AGREEMENT VERSION 14.1, ALL -
DISTRIBUTIONS (WEB DOWNLOAD, DVDS)

Copyright (C) 1991-2014 Altera(R) Corporation.  All rights

reserved. "Quartus" is a registered trademark of Altera Corporation

in the U.5. and other countries. Any other trademarks and trade names

referenced here are the property of their respective owners. Certain

files, programs, or other materials provided in connection with the

Licensed Software may originate or contain components from Third Party

Licensors and are licensed to You pursuant to the terms of the o

@ 1accept the agreement

Do you accept this license?
B = () Ido not accept the agreement

[ < Back ][ Mext = ][ Cancel

e Select the default installation directory, then “Next >”
If a different directory is selected, then the path cannot include spaces).
€2 Installing Quartus Il Web Edition (Free) 14.1.0.186 =R

Installation directory mm
®

Specdify the directory where Quartus IT Web Edition (Free) 14.1.0. 136 will be installed
Installation directory | Cilaltera\14.1

< Back ][ Next > ][ Cancel

SoCKit HW Lab Instructions, Version 14.1 10
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installation, then “Next >”

@a Installing Quartus I Web Edition (Free) 14.1.0.186

Select Components

Select the components you want to install
= Quartus II Web Edition (Free)

=] Devices

[T Arria I {529,0ME)

Cydone v (1078, 7ME)

[C] MAX IIjv (12.8ME)

[C] MAX 10 FPGA (298, 1ME)
ModelSim-Altera Starter Edition (Free) (3594.6MB)
[] Modelsim-altera Edition {3594.6MB)

Quartus II Software (indudes Mios II EDS) (4568ME)

Installs the Quartus II Web Edition software, The Quartus
II Web Edition software is a free, limited-feature version
of the Quartus II Subscription Edition software that
supports selected FPGA and CPLD device families.

Ready to Install

Summary:
Installation directory: C:\alterall4. IWE

Required disk space: 9675 MB
Available disk space: 62859 MB

InstallBuilder

InstallBuilder
< Back ] [ Next > ] [ Cancel
Ready to install, select “Next”:
€+ Installing Quartus I Web Edition (Free) 14.1.0.186 =Nl =

< Back ][ MNext = ][ Cancel

SoCKit HW Lab Instructions, Version 14.1
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Getting Started

e The installation of Qll Web Edition and Cyclone V Device Family will begin:

€ Installing Quartus Il Web Edition (Free) 141.0.186 =R =

Wait while Setup installs Quartus I Web Edition (Free) 14.1.0.186
Instaling
Preparing to Install

InstallBuilder

e | [ hei>

e The installation will continue with ModelSim Starter Edition:

€4 Installing Quartus Il Web Edition (Free) 14.1.0186 =W )
®
Wait while Setup installs Quartus IT Web Edition (Free) 14.1.0, 186
Instaling
Installing ModelSim-Altera Starter Edition (Free)..
L3 I ——
InstalBuilder
< Back Next >
€4 Installing ModelSim-Altera Starter Edition 14.1.0.186 =n =R
Installing
Instaling ModelSim Altera VHDL model files...
L J

SoCKit HW Lab Instructions, Version 14.1
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e Install the USB Blaster Il Driver, select “Finish”

Quartus II Web Edition (Free) 14.1.0.186 Installation Complete

Setup has finished instaling Quartus IT Web Edition (Free) 14. 1.0. 186
Launch USB Blaster II driver installation

Create shortcuts on Desktop

[F] Launch Quartus T1 (54-hit)

[7] Provide your feedback

o =

€4 Installing Quartus Il Web Edition (Free) 14.1.0.186 = |

e Select “Next >”
[ Device Driver Installation Wizan

Welcome to the Device Driver
Installation Wizard!

This wizard helps you install the software drivers that some
computers devices need in order to work.

To continue, click Next.

Device Driver Installation Wizar

The drivers are now installing. ..

. B .
= -

Please wait while the drivers install. This may take some time to complete.

SoCKit HW Lab Instructions, Version 14.1
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e Select “Install”

Would you like to install this device software?

Mame: Altera JTAG cables
d Publisher: Delaware Altera Corporation

|| Always trust software from "Delaware Altera Install Don't Install

Corporation”.

'j,"' You should only install driver software from publishers you trust. How can [ decide which
device software is safe to install?

Device Driver Installation Wizard

The drivers are now installing .5

(2 (2

Please wait while the drivers install. This may take some time to complete.

e Select “Finish”

Device Driver Installation Wizarg

Completing the Device Driver
Installation Wizard

The drivers were successfully installed on this computer.

You can now connect your device to this computer.  your device
came with instructions, please read them first.

Driver Nama Status
~ Altera (WinlUSE) JTAG c... Readyto use

[ Fnsh | [ Cancel |

o select Ml > All Programs -> Altera 14.1.0.181 Web Edition -> Quartus Il Web Edition 14.1.0.181 ->
Quartus Il 14.1 (64 bit)

SoCKit HW Lab Instructions, Version 14.1 14
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Getting Started

e Enable TalkBack

iQuanus]]TaIiE ck e |

Enable Advanced

QUARTUS II SOFTWARE - TALKBACK FEATURE

INTRODUCTION

The TalkBack feature, induded with the Licensed Program(s), enables
ALTERA to receive limited information concerning the Licensed Program(s)
that you use and your compilation of logic designs (but not the logic

design files themselves) using the Licensed Program(s). One of the
primary purposes of the TalkBack feature is to assist ALTERA in
understanding how its customers use the Licensed Program(s) and
ALTERA'S other products, so more effort can be placed on improving the
features most important to users. To disable fenable the TalkBack
feature, run th2_install.exe (or just th2_install in Linux) located in your
quartus/bin folder.

Enable sending TalkBack data to Altera

[ OK. J[ Cancel ][ Help ]

Options” Then you can Enable TalkBack

1.3  Extract the SoCKit Lab Files.

e Create a folder c:\altera_trn on your PC.

If splash screen above doesn’t appear, then select: Tools -> Options. Under Category select: “TalkBack

e Click on the following link to download SoCKIT_Materials_14.1.zip

e Save it to c:\altera_trn on your PC

e  Extract the SoCKIT_Materials_14.1.zip file to this folder

1) SeCKIT_Materials.zip
Open

Open in new window

< bractAl. >

[l WinZip 2
Open with 2

e The c:\altera_trn directory should look like this

5/15/20131 &) 1, Bxtract Compressed (Zipped) Folders

Select a Destination and Extract F

ez will be extracted to this fo

C:haltera_trm|

@Uw? » Local Disk (C:) » alte_:a;tln‘b)
Eile Edit View Tools Help
QOrganize = = Open ~ Burn

. SeCkit
1, SoCKIT_Materials.zip

MNew folder

SoCKit HW Lab Instructions, Version 14.1
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1.4  Get the Cyclone V SoCKit ready for the Labs (Complete this at the Workshop)

Please connect cables to the connectors shown in the diagram below. All cables are provided in your SoCKit.

e Connect the micro or mini (Rev E) USB cable to the USB host connector on your laptop and to the USB Blaster
Il connector on the SoCKit.

e Connect the Power Supply to the Power connector on the SoCKit.

USB Blaster Il UART Ethernet

T s

Power ——— §g9ﬁ t

-
YYD s

There are a few jumpers that require configuring before proceeding with the labs.

e BOOTSEL[2..0] jumpers. These should be configured as "100" to select boot from SD card 3.3V

e  CLKSEL[1..0] jumpers. These should be configured as "00" for the slowest HPS peripheral clock speed
option.

SoCKit HW Lab Instructions, Version 14.1 16
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Getting Started

Please ensure that the jumpers are configured as indicated below.

Modify the default MSEL bit settings. The board needs to be set to configure in the FPPx32, fast, compressed mode.
This will allow u-boot to configure the FPGA.

e SW6 is located on the bottom side of the SoCKit.
e Please change MSEL[0:4] to 01010.

Verify that the JTAG chain is correctly configured. The JTAG chain switch is located in to the right of the green audio
connector.

SoCKit HW Lab Instructions, Version 14.1 17
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Getting Started

e  HSMC_EN should be disabled (left position) and the HPS_EN should be enabled (right position).

o
-
|

- Oy

_ , |
HSMC_ENDERE. & S 1o
HPS_EN ° JTAG CHAIN SW

SoCKit HW Lab Instructions, Version 14.1 18
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1.5 Install the USB Blaster Il Device Driver (Complete if you didn’t install with Quartus Il in section 1.2)

e Turn your SoCKit on.

e Open a NIOS Il 14.0 Command Shell, select BE3ll -> All Programs -> Altera 14.1.0.186 Web Edition -> NIOS I
EDS 14.1.0.186 -> NIOS Il 14.1 Command Shell

e  Type jtagconfig at the prompt and press enter.

¥ | feygdrive/c/altera/14 IWE

5 jtagconfig

1> CU SoCKit [USB-11
82082800 SCSEBAGC. {ES>/5CESEMAG/. .
4BABB477 SOCUHPS

e If the jtagconfig command fails, then complete the following steps
e Press the Windows Start button. Enter devmgmt.msc. Press enter to open the Device Manager.

Programs (1)

=5 devmgmt.msc

' Search Everywhere |

|devmgmt.m5c| < | | Shutdown | » |

— r | 7 — |

“ag X f- ~ : P

% =l R ==
o Navigate to Other Devices in the Device Manager. Expand it to see Unknown Device
e Right click on Unknown Device. Select Update Driver Software.

5 Other devices

gl ! !nEnown deyiceEmy

D TDracessclrS C!!pdate Driver Software..2»
. L 5D host adapters Disable

> -4 Security Devices
By Sound, video an

AW System devices Scan for hardware changes
1ches the Update Driver

Uninstall

Properties L

SoCKit HW Lab Instructions, Version 14.1 19
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Getting Started

e Select Browse my computer for driver software.

bl I Update Driver Software - Unknown Device

How do you want to search for driver software?

# Search automatically for updated driver software
Windows will search your computer and the Internet for the latest driver software |
for your device, unless you've disabled this feature in your device installation
settings.

Browse my computer for driver software
Locate and install driver software manually.

Cancel

e Specify the driver software location. Press Next.

@ [l Update Driver Software - Altera USE-Blaster I (JTAG interface)
Browse for driver software on your computer

Search for driver software in this location:

Cihaltera\14.1_WE\quartus\drivers\usb-blaster-ij - Browse...

[¥] Include subfolders

< Let me pick from a list of device drivers on my computer
This list will show installed driver software compatible with the device, and all driver
software in the same category as the device,

Cancel

e Click Install on the next Screen

[-7] Windows Security IEI
Would you like to install this device software?

MName: Altera JTAG cables
w4 Publisher: Delaware Altera Corporation

1 Always trust software from "Delaware Altera Install ]} Don't Install |
Corporation”.

';@j' You should only install driver software from publishers you trust. How can I decide which
device software is safe to install?

SoCKit HW Lab Instructions, Version 14.1 20

N\NOW  /ADERA, L LNEAR  Five Years Out



Getting Started

e Wait for the driver to complete its installation. Press Close. Notice that device is considered to be
Unconfigured.

) O Update Driver Software - Altera USB-Blaster I (Unconfigured)
Windows has successfully updated your driver software

Windows has finished installing the driver software for this device:

Altera USB-Blaster I (Unconfigured)

=4

e Open a NIOS Il 14.1 Command Shell, select @ -> All Programs -> Altera 14.1.0.186 Web Edition -> NIOS I
EDS 14.1.0.186 -> NIOS Il 14.1 Command Shell

e  Type jtagconfig at the prompt and press enter.

" | fcygdrive/c/altera/14.1WE = | =S

¢ jtagconfig

1> CU SoCKit [USB-11
B2Da2aDD SCSEBAGC. 1ES>/SCEEMAG /. .
4BABA477 S0OCUHPS

CONGRATULATIONSI!

You have just completed all the setup and installation requirements and are now ready to examine the

system-level design.
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MODULE 2. Examine the System Design

Module Objective

In this module you will review the architecture of the design that will be created in Qsys. You will also examine the
layout of the SoCKit. Developing software for an Altera SoC requires an understanding of the design flow of the
Qsys system integration tool. Typically, a design starts with system requirements. These system requirements
become inputs to the system definition. System definition is then first step for implementation in the design flow
process.

21  System Architecture

Th ARM A9 ARM A9 e Sysen

ere are many DDR

components on the SoCKit c = - h l = ] ]

that can be used, including

the LCD, flash, Audio DACs,

and IR. TMC/Tracs Qsk
USB OTG GPIO

The system that we will o Ethemet FOoM e

finish creating in Qsys is —omme ARt

built by using a standard MAND Flash RAM B4KE can

library of re-useable IP FPGA Manager Timers

blocks. The orange section DMA

of this diagram is the HPS

section, while the green __I

section is the FPGA section.

) HSP2FPGA LWHPS2FPGA FPGAZHPS

The HPS section was W] W] =

configured in the HPS FPGA fabric 4

component in Qsys. There sysi0 [ Q (]

are three bridges between Onchip RAM PIOLED [S[g] JTAG Master

the HPS and FPGA sections. PIO Button [STS— Vil JTAG

You will focus on the PIO DIPSW [S [

LWHPS2FPGA bridge

connected peripherals for

this lab, specifically the

LED PIO. The LED PIO is

mapped through the |

bridge into the HPS e I"‘_ nﬂglﬁlm | —

addressable map. Master | ireenace e T e
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2.2 Examine the System Tool Flow

HDL Files

&

/ Quarth ]

FPGA Design
o Edit

~

e Assign Pin-out

e Timing Constraints
e Compile

e Download

>

=Q

Define System

System Description

e Select IP

e Make Connections ARM

e Generate System Software
4 B

Software
Development

e Add Source Files
o Edit

o Build

e Debug

e Run

:

Target

Configure FPGA

Hardware

J Download Application

The diagram above depicts the typical flow for an SoC design. Qsys and Quartus |l generate the following sets of files:

A set of XML files are created that define the system description. These XML files are utilized by the ARM DS-

5 software tool to create a project for the software application. You can find the files here:

SoCKit HW Lab Instructions, Version 14.1
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Open @
Look in: soc_system_hps 0 vl ¥i° [: 3
Bl Desktop -
= 1 Computer
~ s Local Disk (C:)
Recent Items altera_trn
SoCiit
! SoClat_SW _lab_13.1
hps_isw_handoff
Desktop
My Documents
Computer
N
‘& File name: 300kt _SW_lab_13.1'hps_isw_handoff\soc_system_hps_0
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Examine the System Design

e Qsys also generates the HDL files (Verilog or VHDL) for the defined system. These HDL files are then used by
Quartus Il to compile and generate a set of files that defines the hardware system. This set of files includes
the HDL files, Tcl (Tool Command Language) files that define dedicated pin locations for selected HPS
peripherals, Tcl files that define the Multiport Memory Controller in the HPS & FPGA, QIP files that include:
selected IP and SDC (Synopsis Design Constraint files) utilized by TimeQuest to constrain the complete system
design.

e Quartus Il will then generate a simple SOF (SRAM Object File) image that is used to configure the FPGA.

2.3 Examine Arrow's Cyclone V SoCKit

Examine the components on the Cyclone V SoC board hardware:

W HPS Ethernet VGA OUT

FPGA USB 2.0 0TG 10/100/1000 VGA DB-15 Line Mic Line

B System Port Port 24-bit DAC Connector In In Qut
JTAG USB Blaster Il USB-UART

Header Port

USB-UART Caontroller
JTAG Switch

12V DC Power Supply
Connector

Altera USB Blaster II
Controller Chip

Power ON/OFF Switch —U

USB OTG Controller
(ULPI)

Audio Codec
FPGA DDR3 1GB

EPCQ 256Mb

e -HSMC Connector
TSE PHY

LTC Conneclor

Altera 28-nm Cyclone V FPGA

HPS DDR3 1GB with ARM Cortex-A9

CLKSEL Jumper

128x84 Dots LCD BOOTSEL Jumper

G-Sensor Clock Circuit for
FPGA and HPS
LCD Backlight Jumper IR Receiver

FPGA Reset Key
HSMC Voltage-Level

Jumper
HPS User FPGA User FPGA User Keys
Switches Switches
HPS System HPS User KEYs HPS User FPGA User Temperature Sensor
Reset KEYs LEDs LEDs
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24 Block Diagram of the SoCKit

There are many components included on the SoCKit, including the LCD, flash, Audio DACs, and IR.

A block diagram of the board:

ITranafciever I_inh.l

USE cmo-B

Cyclone=V ——

soC’

5CSXFCEDEF31 GEET] ﬁ_u \  Ethemnet

< M—- USBE 2.0 OTG

Micron DORSL

EDRAM %32 1024 MB

> Gobg
S FPGA HPS

[ e usa
- e [ -
ém PR w4 |%6 PTRN 1 :4&2 sz
% » T M
slem HFS | g
eset Reset .I"l"llcfl:}-
< v
TR Bic
LED =B
E é ¥y v v ¥ E E
-N-8-K-
Elide Switch %8
i. é: éﬂuéswgzﬂﬁ] é h
CONGRATULATIONSI
You have just completed the examination of the system-level design
SoCKit HW Lab Instructions, Version 14.1 25

N\NOW /AOERA, L LNEAR Five Years Out



Set up the Quartus Il project

MODULE 3. Set up the Quartus Il project

In this section, you will open a Quartus Il project that contains the Qsys system. In addition, you will specify /O constraints
and settings for this design by executing a Tcl script.

3.1 Launch Quartus Il Project

e lLaunch the Quartus Il v14.1 software: Select E -> All Programs -> Altera 14.1.0.186 Web Edition ->
Quartus Il Web Edition 14.1.0.186 -> Quartus Il 14.1 (64 bit)
e Asplash screen will appear, select Open Existing Project:

Start Designing

i o
New Project Wizard
J—
.o
Recent Projects
2 jesd_eval_hsmec_c5_enc.qpf (C:/aktsra/14 SoCKit_JESD_S! /jesd_eval_hsme_cS_enc/jesd_eval_hsme_c5_enc/jesd_eval_hsme_c5_enc.qpf)
&l top_dsiwic.qpf (C:/altera/14.0/C, / Jtop_dslwic_8_1 ‘parftop_dslwic.qpf)

il ep_glx4.qpf (C:/altera/14.0/Customer/Overtura/PClexs/ep_gled.qpf)

e Now browse to the directory:
C:\altera_trn\SoCKIT_Materials_14.1\SoCKit\SoCKit_HW_lab_14.1 and select
soc_system.gpf and then select Open.

Open Project

@Qv‘ « altera_trn + SoCKIT_Materials 141 » SoCkit b SoCkit HW_Lsh 141 » ~ | 44 | [ Search SoCkit HW,_Lab_141

Organize = Mew folder

. Beachwood *  Name Date modified Type Size

. ACT Fall_14
141

. embedded 14.1

. ip File folder

top

) v File folder
[l sec_system.qpf 3/12/2013 3:06 PM Quartus I Project ... 2KB

. Libraries
3 Documents
J Music
| Pictures

Subversion

E Videos

m

% Homegroup

M LF4714
£, Local Disk ()

€ Network -

File name: soc_system.qpf - [Quartus]l Project File (*.qpf *.q 'J

[ open |v] [ conce |
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Set up the Quartus Il project

If you close the splash screen without opening the project:

e Select File -> Open Project and browse to the directory:
C:\altera_trn\SoCKIT_Materials_14.1\SoCKit\SoCKit_HW_lab_14.1.
e Select soc_system.qpf.

e The Quartus Il project will open. The project already contains a top level Verilog file
(..\top\ghrd_top.v) and a Qsys project (soc_system.qsys) that will be modified in the following

modules.

e Please take a look at the top level file. To do this, double click on the ghrd_top icon in the Project
navigator Window or (select: File -> Open and browse to the ..\top directory and open ghrd_top.v)

Project Mavigator 0y x

A wl=al= i EDAF31C3ES

4 I

I
(@ vierarchy | E|Files | o Designunits | 7% 4|

e The ghrd_top.v contains all of the I/O for the HPS instance as well as all the FPGA I/0. In addition,
you will find the instance for the Qsys component, soc_system at the end of the file.

CONGRATULATIONSI!

Your Quartus II project is set up. You are ready to start building your Qsys system.
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MODULE 4. Build the Qsys System

Module Objective

In this module you add the standard and custom components to the system, make connections where required,
assign the clocks, set arbitration priorities and generate the system.

41 Launch Qsys

e  From the Tools menu, select " A Qsys". There may be a slight delay while the Qsys application

launches.

e Open the File named soc_system.qsys

oo (=]
Lookin: | |, SoCkit HW Lab_14.1 +| e m-
, db
= .
e Vot 1P
Recent Items . top
. soc_system.qsys|
Desktop
E
My Documents
LF4714
= )
Qk File name: soc_system.gsys Open
Network les of LT - -
Files of type: Qsys System Files (*.gsys) v
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% Qs soc_sysem qeys (Chaktera_t\SoCk_ HW_Lob 14 D\SoCkR_HW_Lab 14 D\soc_system.asys] [E=SEE =
File £dt Sysem Generate View Tools Help
'Uhm ] | TR S— e— |lmr(mkﬂm.mmu [e————— -0
. X[ || o= comecaons rame oesapron Expart ook pase end ®e o peode rame
Profect X = B sysid_gsys System ID Pevipheral
B e Conpanent. = & ok ot ko
-l ey - et o]
il = t control_siave Avakon Memory Mapped Seve =] & ox0003_paoe 0x0001_oeo7
Library al [ B hps_0 V Hard Processar System|
kR . o oo resetrea hps_0_f2h_cold_reset_r...
h e o1 rseng resetren Inps_0_£2h_debug_reset..
b teroce Protocsl = [1 o7 fhiwamreset e hps_0_fzh_warm_reset_.
1 ey ertoces s Consotis 7 2 s e
e memos
' . - = ups_0_hps_ta
Fooczssors anl Pelplenie | af hps_0_h2f_reset
ER—— | e
N uskon Memary Mapped Save [P _seram, ox0000_saop
o ok Input ko
NI Master [h2f_axi_do.
- Cock nput dk_o
AXI Save [ _axi_co. ox0000_uooe
[ Codk nput ko
4T Master ..
nterupt Recsver 0 o 0 31—
nterupi Receiver 6 o 10 31
@ LTAG 1 Avalon Master e
—— Ciock Input ok_o
+4 -
o
- &
— ko
| +—
i
4
' - dio
—
=
o
] & dia
[ 4— e 1]
avson tag _siave ™ & oxa002_saon x0002_o07
i i =t
7 & dwn_pio
s & ko
S reset. 1=
P Z & oxnoo:_saso ox0001_opax
o] enens comecsen dipsw_pio_extemal_con...
i ntsrupt Sercr o —
7 5 onchip_memory2 0 |On-Chio Memory (RAM or ROM)
T Wassages =
Ty e mesmage &l
; e
[soc_system hps_0 o FPGA user " (desired_cig_clk_mhz) requested 100.0 M2, butorly achaved 97, 359421 Mz h
0 Ermors, 3Warmings Geneale L. | [Foh
—m e— r—— — ——r I —— -

There will be various components that are already included in the Qsys system, while others will need to be built.

4.2 Build the Qsys System
The first component that you will verify and change is the HPS (Hard Processor System).

Verify the Hard Processor System

The Hard Processor System (HPS) consists of the dual ARM Cortex A9 with various peripherals enabled. The following is a
block diagram of some of the entities available in the HPS.
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Build the Qsys System

Configure the HPS

® Inthe Qsys window, double-click on the hps_0 component

”

<4 K 4> M FXE+

_ Address Map 53| Interconnect Requirements 53| Device Family &2

Use  Connections

S

MName Description
B sysid_gsys System ID Peripheral
dk Clock Imput
T—) reset Reset Input
e Avalon Memory Mapped Slave
Arria VfCydone V Hard Processor System
C— JN_cold_reset_req Reset Input
C— f2h_debug_reset_req Reset Input
C— f2h_warm_reset_req Reset Input
T f2h_stm_hw_events Conduit
A memory Conduit
o hps_io Conduit
H h2f _reset Reset Qutput
f2h_sdram0_clock Clock Imput
f2h_sdram0_data Avalon Memory Mapped Slave
h2f_axi_dock Clock Imput
h2f_axi_master AXI Master
f2h_axi_dock Clock Imput
f2h_axi_slave AXI Slave
h2f_Iw_axi_dock Clock Imput
h2f_lw_axi_master AXI Master
f2h_irgo Interrupt Receiver
fzh_irgi Interrupt Receiver
Figure 4.2.1

Expart

hps_0_f2h_cold_reset_r...
hps_0_f2h_debug_reset...
hps_0_f2h_warm_reset...
hps_0_f2h_stm_hw_ev...
memory

hps_0_hps_io
hps_0_h2f_reset

Clock

clk_0
[clk]
[clk]

clk_0
[f2h_sdram...
clk_0
[h2f_axi_do...
clk_0
[fzh_axi_do...
clk_0
[h2f_lw_axi...

e We will now configure the HPS with the correct pin multiplexing for the peripherals to accommodate the
interfaces on the SoCKit. This process will also include configuring the clocks, the Multiport Memory
Controller, the three high speed ports: HPS to the FPGA, FPGA to HPS and FPGA to Multiport Memory

Controller and various other settings. For complete details please refer to the Cyclone V Device Handbook,

Volume 3: Hard Processor System Technical Reference Manual

Please note that there are multiple tabs for: FPGA Interfaces, Peripheral Pin Multiplexing, HPS Clocks and under the SDRAM

tab there are sub-tabs that are used to configure the HPS.

soC_system > hps_0

Arria V/Cyclone V Hard Processor System

altera_hps

EEGRIHUEFfECES Peripheral Pins | HPS Clocks | SDRAM

|~ General

[] Enable MPU standby and event signals
[7] Enable general purpose signals

[] Enable Debug APE interface

[] Enable FPGA Cross Trigger Interface
[] Enable FPGA Trace Port Interface Unit

Enable System Trace Macrocell hardware events

Figure 4.2.2
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[] Enable baot from fpga signals
[] Enable HLGPT Interface
|' AXI Bridges
FPGA-to-HPS interface width: ‘64bit - |
HPS-to-FPGA interface width: (64hit v |

Lightweight HPS-to-FPGA interface width: [32hit |

30

Five Years Out


http://www.altera.com/literature/hb/cyclone-v/cv_5v4.pdf
http://www.altera.com/literature/hb/cyclone-v/cv_5v4.pdf

Build the Qsys System

4.2.1  Configure the FPGA Interfaces for the HPS

Under the FPGA Interfaces tab, there are various options in the General, AXI Bridges, FPGA to HPS SDRAM, Resets, DMA
Peripheral Request, and Interrupts sections.

Verify that the MPU standby and event signals are disabled except for the System Trace Macrocell (as shown in Fig. 4.2.2).
Refer to the Explanation of options below. These signals are utilized to indicate if the microprocessor is in standby mode to
the FPGA and can wake up an MPCore processor from a wait for event (WFE) state.

Verify that Enable MPU general purpose signals are disabled (as shown in Fig. 4.2.2). This is used to enable a pair of 32-bit
unidirectional general purpose interfaces between the FPGA and the FPGA Manager in the HPS.

e The FPGA Manager offers the following: "Used to configure the FPGA, Mimics passive parallel 32-bit
configuration, Partial Reconfiguration, Compressed FPGA configuration images, AES encrypted configuration
images, Monitors the configuration-related signals, provides 32 general purpose inputs and 32 general-
purpose outputs to the FPGA".

Ensure that the "Enable Debug APB interface", "Enable FPGA Cross Trigger Interface", and "Enable FPGA Trace Port
Interface Unit" are all disabled (as shown in Fig. 4.2.1.1).

Ensure that the "Enable System Trace Macrocell Hardware events" is enabled (as shown in Fig. 4.2.1.1).
Explanation of options:

e Debug APB interface - Enables debug interface to the FPGA, allowing access to debug components in the
HPS.

e Enable System Trace Macrocell hardware events - Enables System Trace Macrocell (STM) hardware events,
allowing logic inside the FPGA to insert messages into the trace stream.

e Enable FPGA Cross Trigger interface - Enables the cross trigger interface (CTI), which allows trigger sources
and sinks to interface with the embedded cross trigger (ECT).

e Enable FPGA Trace Port Interface Unit - Enables an interface between the trace port interface unit (TPIU)
and logic in the FPGA. The TPIU is a bridge between on-chip trace sources and a trace port.

Ensure that the "Enable boot from fpga signals" is disabled (as shown in Fig. 4.2.1.1).

Explanation of options:

o Enable boot from FPGA ready - Enables an input to the HPS indicating whether a preloader is available in on-
chip RAM. If the input is asserted, a preloader image is ready at memory location 0.

o Enable boot from FPGA on failure - Enables an input to the HPS indicating whether a fallback preloader is
available in on-chip RAM. If the input is asserted, a fallback preloader image is ready at memory location 0.
The fallback preloader is to be used only if the HPS boot ROM does not find a valid preloader image in the
selected flash memory device.

e Enable HGPL Interface - This will instantiate 14 general purpose DDR inputs. If you check these signals will be
available in the HPS 10 conduit in Qsys and are at same IO voltage as the DDR interface. Please refer to the
Pin Connection Guidelines.

SoCKit HW Lab Instructions, Version 14.1 3
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Ensure that the "Enable HGPL Interface" is disabled (as shown in Fig. 4.2.1.1).

In the AXI Bridge section, ensure both the "FPGA-to-HPS interface width" is set to 64-bit and "HPS-to-FPGA interface
width" is set to 64-bit (as shown in Fig. 4.2.1.1). Both of these interfaces can be set to 32, 64, 128-bits or Unused.

e Enabling the FPGA to HPS interface allows masters within the FPGA to access to HPS peripherals.
e Enabling the HPS to FPGA interfaces allows HPS masters to access the FPGA peripherals.

Verify that the "enable the Lightweight HPS-to -FPGA interface width" is to be set to 32 bit. A 32 bit AXl interface
optimized for low latency is thus enabled (as shown in Fig. 4.2.1.1).

After making these changes, the HPS should now look like this:

Arria V/Cyclone V Hard Processor System

altera_hps

FPGA Interfaces | peripheral Pins | HPS Clocks | SDRAM|

[~ General

Enable MPU standby and event signals

Enable general purpose signals

Enable Debug APB interface
Enable System Trace Macrocell hardware events
[ Enable FPGA Cross Trigger Interface

[] Enable FPGA Trace Part Interface Unit

[] Enable boot from fpga signals
[] Enable HLGPI Interface
[* Ax1 Bridges
FPGA-to-HPS interface width: 64-bit
HPS-to-FPGA interface width: 64-bit

Lightweight HPS-to-FPGA interface width: | 32 it

-

Figure 4.2.1.1

Scrolling down the FPGA interface tab, there are more options. There are sections for the FPGA-to-HPS SDRAM Interface,
Resets and DMA Peripheral Request.

Verify the FPGA to HPS SDRAM Interface section has one entry: f2h_sdram0.
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|' FPGA-to-HPS SDRAM Interface

Click the '+ and - buttons to add and remove FPGA-to-HPS SDRAM ports.

Mame Type Width
f2h_sdram0 |.A.va lon-MM Bidirectional (256

Figure 4.2.1.2

e This enables the FPGA to gain access to the HPS SDRAM subsystem from the FPGA fabric. This particular FPGA
to HPS interface provides up to six ports to the HPS’s multiport SDRAM controller. The bus interface provided
to the FPGA can be AXI-3 or Avalon Memory Mapped.

Ensure that the “Enable FPGA-to-HPS debug reset request” and “Enable FPGA-to-HPS warm reset request” and “Enable
FPGA-to-HPS cold reset request” are set to enabled (as shown in Fig. 4.2.1.3). There are several options and the Reset
Manager is very sophisticated. Therefore, please refer to the Cyclone V Device Handbook Volume 3: Hard Processor System
Reference Manual: Section |, Chapter 3 for details on the Reset Manager.

Explanation of reset options; Do NOT implement these changes:

e Enable HPS-to-FPGA cold reset output - Enable interface for HPS-to-FPGA cold reset output

e Enable HPS warm reset handshake signals - Enable an additional pair of reset handshake signals allowing
soft logic to notify the HPS when it is safe to initiate a warm reset in the FPGA fabric.

o Enable FPGA-to-HPS debug reset request - Enable interface for FPGA-to-HPS debug reset request

o Enable FPGA-to-HPS warm reset request - Enable interface for FPGA-to-HPS warm reset request

o Enable FPGA-to-HPS cold reset request - Enable interface for FPGA-to-HPS cold reset request

Verify the DMA peripheral request is set to the default of No for each of the eight channels (as shown in Fig. 4.2.1.3). The

designer can enable each direct memory access (DMA) controller peripheral request ID individually. Each request ID enables
an interface for FPGA soft logic to request one of eight logical DMA channels to the FPGA.

Ensure that the "Enable FPGA-to-HPS interrupts” is enabled (as shown in Fig. 4.2.1.3). This enables interrupt signals from the
FPGA to the MPU in the HPS.
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[~ Resets
[] Enable HPS-to-FPGA cold reset output

[] Enable HPS warm reset handshake signals
Enable FPGA-to-HPS debug reset request
Enable FPGA-to-HPS warm reset request

Enable FPGA-to-HPS cold reset request

|" DMA Peripheral Request

Peripheral Request ID Enabled

m

5585587

Figure 4.2.1.3

The "HPS to FPGA" interrupts should all be disabled (as shown in Figure 4.2.14). An interrupt signal can be provided to the

FPGA for each one of the peripherals that are included in this section.

After making these changes, the HPS should now look like this:

[~ HPS-to-FPGA
[ Enable CAN interrupts

[7] Enable dock peripheral interrupts

[ Enable CTI interrupts

[] Enable DMA interrupts

[ Enable EMAC interrupts (for EMACO and EMAC1)
[ Enable FPGA manager interrupt

[] Enable GPIO interrupts

[ Enable 12C-EMAC interrupts (for 12C2 and I12C3)
[ Enable 12C peripheral interrupts (for 12C0 and 12C1)
[] Enable L4 timer interrupts

[ Enable NAND interrupt

[] Enable OSC timer interrupts

[ Enable Quad SPI interrupt

[ Enable SDMMC interrupt

[ Enable SPI master interrupts

[ Enable SPI slave interrupts

[] Enable UART interrupts

[ Enable USE interrupts

[ Enable watchdog interrupts

Figure 4.2.1.4
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4.2.2  Configure HPS' Peripheral Pin Multiplexing (MAC, NAND, QSPI, SDIO, USB)

Under the Peripheral Pin Multiplexing tab, there are options to enable the HPS peripherals. The peripherals in the HPS are

available to as many as three sets of HPS I/O pins. An HPS pin multiplexing table is available at the bottom of this tab to make

it a simpler and more intuitive task for the designer. Also, please note that all HPS peripherals are available for pin out via the

FPGAs pins.

If you put your cursor over a particular peripherals mode icon: a list of the signal to pin for a particular I/0 set per pin is

displayed in a pop-up box.

FPGA Interfaces | Peripheral Pins | Hpsg clocks|snp.m

[~ Ethernet Media Access Controller

SoCKit HW Lab Instructions, Version 14.1
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EMACD pin: Unused -
EMACO mode: N/A - |

EMAC1 pin: HPS1/O5et0
EMAC1 mode: 'REMII -

[~ NAND Flash Controller EMAC1 mode (EMACL_Mode):
MAND pin: \Unused | Signal Membership Per Mode Usage Option:
NAND mode: NA v RGMII | RGMII with [2C3

[~ Quad SPI Flash Controller MDC X
QSPI pin: wes1o| [ moo | x

SPI mode: [ -
° 155 7 Rxpo | x X

[ SD/MMC Controller Rxp1 | x X
SDIO pin: HPS 10

- RXD2 X X
SDIO mode: 4-bit Datl
' RXD3 X X

[~ USB Controllers ax okl x X
LUSBO pin: mesed -

USBO PHY interface mode: |/ | RXCTL)| X X
SB1 pin: HPs1jo || TXDO X X
USB1PHY interface mode: | spR witd | TxD1 ¥ X

[~ SPI Controllers TXD2 X X
SPIMOD pin: ijs 1o Txp32 X X
SPIMO mode: 5

:Slngle 3l TX CLK X X
SPIM1 pin: HPs 1jO
SPIM1 mode: 'Single S| Lh A e i
Figure 4.2.2.1
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To see a pin multiplexing error, change the EMACO pin multiplexing which is default set to Unused to be HPS 1/0 Set 0.

Change the default setting in this archive from

FPGA Interfaces| Peripheral Pin Multiplexing | HPS Clocks | SDRAM|

Hower the mouse cursor over the mode parameters for a tooltip regarding signal membership details.

|' Ethernet Media Access Controller

to be

EMACO pin multiplexing: | Unuszed
EMACO mode: NIA - |

EMAC1 pin muttiplexing:  |[HPS YO SetD - |
EMACT mode: RGMI

-

Figure 4.2.2.2

FPGA Interfaces | Peripheral Pins | HPS Clocks | SDRAM |

|~ Ethernet Media Access Controller
EMACO pin: HPS IO SetD
EMACO mode: .F'.GMII -
EMAC 1 pin: HPS1/OSet0
EMAC1 mode: 'RGMII -
Figure 4.2.2.3

There will be errors in the Messages Window:

Type Path Message
B[] 3 Errars
e soC_system.hps_0 Refer to the Peripherals Mux Table for more details, The selected peripherals ‘EMACD and 'USE1' are conflicting.
0 soc_system.hps_0 Refer to the Peripherals Mux Table for more details. The selected peripheral 'EMACT' and 'GPIO00" are conflicting.
e soc_system.hps_0 Refer to the Peripherals Mux Table for more details. The selected peripheral 'EMACT' and 'GPIO0S are conflicting.

Figure 4.2.2.4

These errors occur since each peripheral available on the HPS go to at least one set of HPS I/O. The multiplexing for each I/0
Set is controlled by selecting the specific HPS peripheral's 1/O Set. When the EMAC pin multiplexing was selected, the pins for
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several of the other peripherals had already used these I/O pins, and therefore a conflict. (Starting in version 13.1, an HPS pin
multiplexing table is available at the bottom of the “Peripheral Pin Multiplexing” tab to make this a simpler and more intuitive
task for the designer.) Please note that all pins that aren't utilized by an HPS peripheral can be Enabled as a GPIO pin for use
as a General Purpose I/0 Pin.

Conflicts (column and row are in Red/Burgundy) :

[~ Peripherals Mux Table

Figure 4.2.2.5

No Conflicts: (For the peripheral selected mux_select column is green):

[~ Peripherals Mux Table
RGMII0_TX_CLK
RGMIIO_TXDO
RGMIIO_TXD1
RGMIIO_TXD2
RGMIID_TXD3
RGMIID_RXD0
RGMII0_MDIO 12C2.5DA (SetD)
RGMIIO_MDC 12C2.5CL (Set0)
RGMIIO_RX_CTL
RGMIIO_THX_CTL
RGMIIO_RX_CLK
RGMIIO_RXD1
RGMIIO_RXD2
RGMII0_RXD3

Figure 4.2.2.5

Change the EMACO pin multiplexing back to Unused to remove the errors.
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As the selected pins need to match the Cyclone V SoC board layout and they need to avoid errors, verify that the Qsys
settings match the following screenshots to enable the Ethernet MAC, QSPI Flash Controller, SDMMC, USB Controller, SPI
Controllers, Uart Controllers, and 12C Controllers.

FPGA Interfaces | Peripheral Pins | HPS Clocks | SDRAM|

[~ Ethernet Media Access Contraoller

EMACO pin: Unused |
EMACO mode: NjA |

EMAC1 pin: HPS /O Set0 w |
EMAC1 mode: RGMII |

[~ NAND Flash Controller
NAND pin: Unused -
NAND mode: .

[* Quad SPI Flash Controller
QSPI pin: HPS /0 5et0 v
5P1 mode: 155 o |

[* sD/MMC Controller

SDIO pin: HPS1jO Set0 « |
SDIO mode: 4bit Data -
Figure 4.2.2.6

[~ USB Controllers
USBO pin: Unused -
USBO PHY interface mode: [/ + |

USB1 pin: HPS /O SetD |
USB 1 PHY interface mode: |SDR with PHY dock output mode |

[ SPI Controllers

SPIMO pin: HPS /O Set0 v |
SPIMO mode: :Single Slave Select +
SPIM1 pin: HPS 1/0 5et0 v |
SPIM1 mode: :Single Slave Select -
SPISO pin: Unused =)
SPISO mode: A < .
SPIS1 pin: [unused =
SPIS1 mode: :N,FA = .

[* UART controllers

UARTO pin: HPS /O SetD v |
UARTO mode: No Flow Control |
UART1 pin: .Unused v.
UART 1 made: :N,rp. = .
Figure 4.2.2.7
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~ I2C Controllers

12C0 mode:
12C1 pin: HPS 1jO Set0 -
12C1 mode:

12C2 pin: Unused -
[2C2 mode: N/A

12C3 pin: Unused -
[2C3 mode: MA -

= CAN Controllers
CAND pin: Unused -
CAMNO mode: MA -

CAN1 pin; Unused -
CAN1 mode: N/A

IIII IIIIE

~ Trace Port Interface Unit
TRACE pin; Unused -
TRACE mode: N/A -

Figure 4.2.2.8

There should be no errors and the conflict setting should look as follows:

|~ Peripherals Mux Table
RGMIID_TX_CLK EMACO.TX_CLK (SetD) [ —— o7
RGMIIO_TXDO EMACD. TXDO (Setd) [E— -1
RGMIID_TXD1 EMACD.TXD1 (Setd) [ GEO0Z —
RGMIID_TXD2 EMACO.TXD2 (Setd) [ GRIC0E
RGMIIO_TXD3 EMACD. TXD3 (Setd) ( GEIO0E
RGMII0_RXDO EMACO.RXD (SetD) [ GEIOOE
RGMIIO_MDIO 12C2.SDA (Set0) EMACO.MDIO {Setd) ( GEIO0E
RGMIIO_MDC 12C2.5CL {Set0) EMACD.MDC {Set0) [ CEO0T
RGMIIO_RX_CTL EMACD RX_CTL (Setd) [E—— -1
RGMIID_TX_CTL EMACO.TX_CTL (S=t0) [ crom
RGMIID_RX_CLK EMACD.RX_CLK (Set0) [ i Ten
RGMIIO_RXD1 EMACO.RXD1 [Setd) [ GPIOTT
RGMIID_RXD2 EMACO.RXD2 (SetD) [ GROTZ
RGMIID_RXD3 EMACO.RXD3 [Setd) [ GPOTS
NAND_ALE NAND.ALE (Set0) [ CEGTE —
NAND_CE NAMND.CE (Setl) [ [cizife I3
NAND_CLE NAMD.CLE {SetD) [ [cizife [ 3
NAND_RE NAND.RE (Set0) [ GEIOTT
NAND_RB NAND.RB (Setl) [ [cizife -3
NAND_DQOD NAND.DQO (Setd) [ GEOTE
NAND_DG1 NAND.DQ1 (Setd) [ GPOZ0
NAND_DQ2 NAND.DQ2 (Set0) [ TEGET —
HAND_DQ3 NAND.DQ3 (SetD) ( CROZE
NAND_DQ4 EMAC1.TX_CTL (Set0) NAND.DQ4 (Set0) [ GRICEE
NAND_DQ5 EMACA.RX_CLK (Setl) NAND.DQ5 (Set) i GFICZE
NAND_DQ5 EMAC1.RXD1 (Set0) NAND.DQE (Set0) [ GRICE
NAND_DQT NAND.DQT (Setd) [ GRIOZE
NAND_WP EMAC1.RXD3 (SetD) NAND.WP (Set0) C— Griooy
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. _______________________________________________________________________________________________________________________________________________________________________________________________|]

NARD_WE SIS (Sa0)1 ] NAND W (5510

QSPI_I00
QsPI_I01
QsPI_lo2
QsPI_l03
QSPI_SS0
QSPI_CLK
QSPI_551
SDMMC_CMD
SDMMC_PWREN
SDMMC_DOD
SDMMC_DM1
SDMMC_D4
SDMMC_D5
SDMMC_D8
SDMMC_D7
SDMMC_FB_CLK_IN
SDMMC_CCLK_OUT
SDMMC_D2
SDMMC_D3
TRACE_CLK
TRACE_DO
TRACE_DM
TRACE_D2
TRACE_D3
TRACE_D4
TRACE_D5
TRACE_D6
TRACE_D7
SPIMO_CLK
SPIMO_MOSI
SPIMO_MISO
SPIMO_S5S0
UARTO_RX
UARTO_TX
12C0_SDA
12C0_SCL
CANO_RX
CAND_TX

Figure 4.2.2.9

4.2.3 Configure HPS Clocks

Select the HPS Clocks tab. Under the Input Clocks sub tab; there are selections to set the External Clock pins provided to the
HPS: EOSC1 & EOSC2, the ability to enable clocks between the HPS to FPGA and FPGA to HPS. New in version 14.0 is an Output
Clock tab.

4.2.3.1 Configuring HPS Input Clocks

The "ESOC1 clock frequency and ESOC2 clock frequency" External Clock Sources should all be set to 25.0 Mhz and 25.0 Mhz
(as shown in Figure 4.2.3.1). Setting EOSC1 & EOSC2 is new in version 14.0.
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The bullets below are descriptive. Do NOT implement these changes.

Explanation of user clock options for the Output tab:

e External Clock Sources: EOSC1 and EOSC2 are based upon the frequency at the HPS I/O pins: HPS_CLK1 and

HPS_CLK2, D25 and F25 for the 5CSXFC6D6F31C6

e Enable HPS-to-FPGA user 0, 1, 2 clock - Enable main PLL from HPS to FPGA

User 0, 1, 2 clock frequency - Specify the maximum expected frequency for the main PLL
o Enable FPGA-to-HPS peripheral PLL reference clock - Enables the interface for FPGA fabric to supply

reference clock to HPS peripheral PLL

e Enable FPGA-to-HPS SDRAM PLL reference clock - Enables the interface for FPGA fabric to supply reference

clock to HPS SDRAM PLL

Arria V/Cyclone V Hard Processor System

altera_hps

| FPGA Interfaces | Peripheral Pins | HPS Clocks | sDRAM|

Input Clocks | Qutput Clocks

[ External Clock Sources

EQSC1 dodk frequency: 25.0 MHz
EOQSC2 dodk frequency: 25.0 MHz

[* FPGA-to-HPS PLL Reference Clocks

[ Enable FPGA-to-HPS SDRAM PLL reference dock

["] Enable FRGA-to-HPS peripheral PLL reference dock

FPGA-to-HPS SDRAM PLL reference dock frequency:  |p.g MHz
FPGA-to-HPS peripheral PLL reference dock frequency: |g.o MHz
Figure 4.2.3.1

The PLL reference clocks between the HPS and FPGA are NOT enabled for this lab. Therefore,

your screenshot should be as shown below:

|~ FPGA-to-HPS PLL Reference Clocks

[ Enable FPGA-to-HPS SDR.AM PLL reference dock

[] Enable FPGA-to-HPS peripheral PLL reference dock
FPGA-to-HPS SDRAM PLL reference dodk frequency:  |g.g
FPGA-to-HPS peripheral PLL reference dock frequency: g g

Figure 4.2.3.2
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None of the HPS Peripherals were selected to be available in the FPGA; therefore, none of these
clocks are Peripheral FPGA Clocks:

|' Peripheral FPGA Clocks

EMACO emacd_md_ck dock frequency: 100 MHz
EMACD emacD_gtx_dk dock frequency: 100 MHz
EMAC1 emacl_md_dk dodk frequency: 100 MHz
EMAC1 emacl_gtx_dk dock frequency: 100 MHz
QSPI gspi_sdk_out dock frequency: 100 MHz
SPIMO spim0_sdk_out dodk frequency: 100 MHz
SPIM1 spim1_sdk_out dock frequency: 100 MHz
12C0 i2c0_ck dock frequency: 100 MHz
12C1i2c1_dk dock frequency: 100 MHz
12C2i2c2_dk dock frequency: 100 MHz
12C3i2c3_dk dock frequency: 100 MHz

Figure 4.2.3.3

For example, if SPM1 were selected to be available in the FPGA under the Peripheral Pins tab,

[~ sPi Controllers
SPIMO pin multtiplexing:

'HPS U0 Set0 « |

SPIM0 mode: :Single Slave Select

SPIM1 pin multtiplexing:

SPIM1 mode: Full -

SPISO pin multiplexing: :FPGA l o

SPISD mode: | '

SPIS1 pin multiplexing: :Unusef; o

SPIST mode: o '
Figure 4.2.3.4

Then, the result in the HPS Clocks tab would be:

[~ Peripheral FPGA Clocks

EMACD emac0_md_clk clock frequency: | 1gp MH=z
EMACD emac0_gtx_clk clock frequency: | 1np MHz
EMAC1 emaci_md_clk clock frequency: |1gg MHz
EMACT emaci_gbx_clk clock frequency: | 1gp MH=z
QSPl gspi_sclk_out clock freguency: 100 MHz
SDIO sdio_cclk clock frequency: 100 MHz

SPIMO spim0_sclk_out clock frequency: | {qp MHz

SPIM1 spim1_sclk_out clock freque

12C0 i2c0_clk clock freguency: 100 MHz
2C1 i2c1_clk clock freguency: 100 MHz
12C2 i2c2_clk clock freguency: 100 MHz
12C3 i2c3_clk clock freguency: 100 MHz
Figure 4.2.3.5

If you made the change to SPM1 pin multiplexing change it back to UNUSED now!
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4.2.3.2 Configuring HPS Output Clocks (Output Clocks is NEW in Version 14.0)
4.2.3.2.1 HPS Output Clocks: Clock Sources

Please leave the settings to the default:

| Clock Sources

Peripheral PLL reference dock source: E0SC1 dock -
SOMMC dock source: Peripheral MAND SDMMC dock -
MAND dock source: Peripheral MAND SDMMC dock
Q5PI dock source: Main QSPI dock -
L4MP dock source: Peripheral base dock -
L4 5P dodk source: Peripheral base dock

Figure 4.2.3.6

The bullets below are descriptive. Do NOT implement these changes.

Explanation of user clock options for the Output tab:

e Peripheral PLL reference clock source: This selects the reference clock for the HPS peripherals and can be set
to the: EOSC1 Clock, EOSC2 Clock, FPGA-to-HPS peripheral reference clock. EOSC1 & EOSC2 are based upon
the frequency at the HPS 1/0O pins: HPS_CLK1 and HPS_CLK2, D25 and F25 for the Cyclone V SX
5CSXFC6D6F31C6. The FPGA-to-HPS peripheral reference clock is set under the Input tab. Please refer to
Figure 4.2.3.7

e SDMMIC clock source — Sets the clock source for the Secure Digital/Multimedia Card controller
FPGA-to-HPS peripheral reference clock — f2h_periph_ref_clk as defined in the input Clock tab
Main NAND SDMMC Clock — Selects the PLL output from the “Main Clock Group” MPU, L3 & L4 & Debug PLL
C4 from the HPS Clock Manager
Peripheral NAND SDMMC Clock — Selects the PLL output from the “Peripheral Clock Group” Peripheral PLL
C3 from the HPS Clock Manager
Please refer to Figure 4.2.3.8

e NAND clock source — Sets the clock source for the NAND Flash controller
FPGA-to-HPS peripheral reference clock — f2h_periph_ref_clk as defined in the input Clock tab
Main NAND SDMMC Clock — Selects the PLL output from the “Main Clock Group” MPU, L3 & L4 & Debug PLL
C4 from the HPS Clock Manager
Peripheral NAND SDMMC Clock — Selects the PLL output from the “Peripheral Clock Group” Peripheral PLL C3
from the HPS Clock Manager
Please refer to Figure 4.2.3.9

SoCKit HW Lab Instructions, Version 14.1 43

NA\OW  /AB[ERYA, L7T|-E|DEO'}B Five Years Out



Build the Qsys System

e  QSPI clock source — Sets the clock source for the QSPI controller

FPGA-to-HPS peripheral reference clock — f2h_periph_ref_clk as defined in the input Clock tab

Main QSPI Clock — Selects the PLL output from the “Main Clock Group” MPU, L3 & L4 & Debug PLL C3 from

the HPS Clock Manager

Peripheral QSPI Clock — Selects the PLL output from the “Peripheral Clock Group” Peripheral PLL C2 from the

HPS Clock Manager

Please refer to Figure 4.2.3.10
o L4MP clock source — L4 Master Peripheral Clock: 14_mp_clk

Main Clock — Selects the PLL output from the “Main Clock Group” main_base_clk or C1 from the Main PLL
Peripheral base clock — Selects the PLL output from the “Peripheral Clock Group” from the Peripheral PLL C4
o L4SP clock source — L4 Slave Peripheral Clock: 14_sp_clk

Main clock - Selects the PLL output from the “Main Clock Group” main_base_clk or C1 from the Main PLL
Peripheral base clock — Selects the PLL output from the “Peripheral Clock Group” from the Peripheral PLL C4

|~ Clock Sources

Peripheral PLL reference dock source:
SDMMC dock source:

MAMD dock source:

QSPI dock source:

L4 MP dock source:

L4 5P dock source:

[EOSC1 dock -
EQSC2 cock

FPGA-to-HPS peripheral reference dock
Main Q5PI clock v

:Peripheral base dodk v:
:Peripheral base cock v:

Figure 4.2.3.7
| Clock Sources
Peripheral PLL reference dock source: EOSC1 dock -
SDMMC dlock source: Peripheral NAND SDMMC dlock -

MAMND dodk source:
QSPI dock source:

L4 MP dock source:
L4 5P dock source:

FPGA-to-HPS peripheral reference dock
Main MAMND SDMMC dodk

_Peripheral basze cock |
:Peripheral base cock v:

Figure 4.2.3.8

| Clock Sources

Peripheral PLL reference dodk source:

SDMMC clock source:
MAMD clock source:
QSPI dock source:
L4 MP dlock source:
L4 5P dock source:

SoCKit HW Lab Instructions, Version 14.1
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EOSC1 dock
Peripheral NAND SOMMC dock

Peripheral NAND SDMMC dock

Main MAMD SDMMC daock

Peripheral base clock |

Figure 4.2.3.9

FPGA-to-HPS peripheral reference dock
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| Clock Sources

Peripheral PLL reference dock source: EOSC1 dock -
SDMMC dlock source: Peripheral NAND SDMMC clock -
MAND dock source: Peripheral NAND SDMMC dock

Q5PI dodk source: ;Majn QSPI dodk - |
L4 MP dock source: FPGA-to-HPS peripheral reference dock

L4 5P dock source:

Figure 4.2.3.10

4.2.3.2.2 HPS Output Clocks: Main PLL Output Clocks - Desired Frequencies

The "ESOC1 clock frequency and ESOC2 clock frequency" External Clock Sources drive the HPS Clock manager PLLs (Main
Clock Group, Peripheral Clock Group, SDRAM Clock Group & OSC1 Clock Group PLLs).

Please leave the settings (except uncheck Use default MPU clock frequency):

* Main PLL Qutput Clocks - Desired Frequencies
Default MPU dock frequency: 925.0 MHz

Use default MPU dodk frequency

MPU dodk frequency: 300.0 MHz
L3 MP dock frequency: 185.0 w | MHz

L3 5P dock frequency: :92, 5 o i'v‘IHz

Debug AT dock frequency: :25,0 — ] MHz

Debug dock frequency: :12. 5 w ] MHz

Debug trace dock frequency: :25,0 -v | MHz

L4 MP dock frequency: | 100.0 | MHz
L4 5P dock frequency: 100.0 MHz

Configuration/HP5-to-FPGA user 0 dock frequency: 123333333 MHz

Figure 4.2.3.11

The bullets below are descriptive. Do NOT implement these changes.

o MPU clock frequency — Sets the clock frequency for the processor
[] Use default MPU dock frequency

must be unchecked to configure with own frequency
o L3MP clock frequency — L3 Master Peripheral clock frequency: 1I3_mp_clk

Divides by 1 or 2 the PLL output from the main_base_clk or C1 from the Main PLL
o L3SP clock source — L3 Slave Peripheral Clock: I3_sp_clk

SoCKit HW Lab Instructions, Version 14.1 45

N\NOW /AOERA, L LNEAR Five Years Out



Build the Qsys System

Can be divided by 1 or 2 the L3PM clock (I3_mp_clk)
o Debug AT clock frequency — Debug AT Clock: dgb_at_clk
Derived from the Main PLL: C2 output and can be divided by 1 or 2
e Debug Timer clock frequency — Debug Timer Clock: dgb_timer_clk
Derived from the Main PLL: C2 output
e Debug clock frequency — Debug Clock: dgb_clk

Originates from dbg_at_clk divided by 2 or 4, derived from the Main PLL: C2 output

e Debug trace clock frequency — Debug trace clock: dgb_trace_clk

Originates from dbg_base_clk divided by 1, 2, 4, 8 or 16, derived from the Main PLL: C2 output

o L4 MP clock frequency — L4 Main Peripheral clock: 14_mp_clk

Originates from dbg_base_clk or periph_base_clk divided by 1, 2, 4, 8 or 16
o L4 SP clock frequency — L4 Slave Peripheral clock: 14_sp_clk

Originates from dbg_base_clk or periph_base_clk divided by 1, 2, 4, 8 or 16
e  Configuration HPS-to-FPGA user 0 clock frequency — h2f userO_clock

Originates from cfg_h2f user0_base_clk which is the Main PLL: C5 output

P mpu_periph_clk

- mpu_I2_ram_clk

EE“E (o | mpubase dk »| CockGate . > mpu_ck
q [mnbasedk  pl dockGate P Clock Gate }» H_main_ck
= dbg_base_clk > | P — I P 13_main_clk
a main_qspi_base_clk > ToRh - byTar2 -~ 13_mp_clk
¢4 | main_nand_sdmme_base_dk >~ Coaﬁlsler _ b.’-““ .
¢ | chahai_userd_base_ck i{]—»\u”f'g% }—p‘ Clock Gate ’_> u_mp_dk

periph_base_clk (from Peripheral PL LC4)

= ,‘ Divide by
4‘_/- 1,2.4,8,0116

Clock Gate H 14_sp_clk

»|  Divideby

1,2,0r4

by2or4

T’ Clock Gate dbg_at_clk
vide Clock Gate dbg_ck

Divide by
1,2,4,8,0r16

4

—®| (lockGate

dbg_trace_clk

Figure 4.2.3.12
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4.2.3.2.3 HPS Output Clocks: Peripheral Output Clocks — Desired Frequencies

Please leave the settings (except uncheck Use default MPU clock frequency):

|"' Peripheral PLL Output Clocks - Desired Frequencies

SDMMC dock frequency:

MAMD dock frequency:

QSPI dock frequency:

EMALCO dock frequency:

EMAC1 dock frequency:

1JSB dock frequency:

SPI dock frequency:

CAND dock frequency:

CAN1 dock frequency:

GPIO debounce dock frequency:

Figure 4.2.3.13

EMACO clock frequency — emac0_base_clk
Originates from the Peripheral PLL, CO output: emacl_base_clk
e EMAC Iclock frequency — emacl_base clk
Originates from the Peripheral PLL, C1 output: emacl_base_clk
o USB clock frequency — usb_mp_clk
Originates from the Peripheral PLL, C4 output: periph_base_clk
Can be divided by 1,2,4,6, or 16
o SPI clock frequency —spi_m_clk
Originates from the Peripheral PLL, C4 output: periph_base_clk
Can be divided by 1,2,4,6, or 16
e CANO clock frequency — can0_clk
Originates from the Peripheral PLL, C4 output: periph_base_clk
Can be divided by 1,2,4,6, or 16
e CANI1 clock frequency — canl_clk
Originates from the Peripheral PLL, C4 output: periph_base_clk
Can be divided by 1,2,4,6, or 16

e  GPIO clock frequency — Originates from the Peripheral PLL, C4 output: periph_base_clk

Divided by 24
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SDMMIC clock frequency — Originates from the Peripheral PLL: C3 output: periph_nand_sdmmc_base clk
NAND clock frequency — Originates from the Peripheral PLL: C3 output: periph_nand_sdmmc_base_clk
QSPI clock frequency — Originates from the Peripheral PLL: C3 output: periph_gspi_base_clk
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Periglze[a\ o | emaco_base_dk p| ClockGate | » emaco_ck
a emacl_base_clk | CodGate | emac_ck
periph_gspi_base_dlk
Q P To Flash Controller Clocks
periph_nand_sdmmc_base_dk
(&] P> To Flash Controller Clocks
periph_base_dk TomainPL L group
4 P 14 mp_clk &14_sp_clk
h2f_user1_base_clk — multiplexer
) —_— = Divide by
P 1.2.4.8,0r16 —®| ClockGate | ush_mp_dk
w | Divide by )
> 048016 — | ClockGate [—® spi_m dk
Divide by
0_clk
P 12.4.8,0r16 —» ClockGate = @n0_c
Divide by
> o 4sals —»{ ClockGate  |— canl1_dk
24-Bit .
Divider —» ClockGate  ——» gpio_db_clk
P ClockGate | h2f userl_clock
Figure 4.2.3.14
4.2.3.2.4 HPS Output Clocks: HPS-to-FPGA user clocks
Please leave the default settings:
|* HPS-to-FPGA User Clocks
[] Enable HPS-to-FPGA user O dock
[] Enable HPS-to-FPGA user 1 dock
HPS-to-FPGA user 0 dock frequency: 123.333333 MHz
HPS-to-FPGA user 1 dodk frequency: 100.0 MHz

Figure 4.2.3.15

o Enable HPS-to-FPGA user 0 clock — h2f userQ_clock
Originates from cfg_h2f _user0_base_clk which is the Main PLL: C5 output
Refer to Figure 4.2.3.12

e Enable HPS-to-FPGA user 1 clock
Originates from h2f_userl_base_clk which is the Peripheral PLL: C5 output
Refer to Figure 4.2.3.14

e Enable HPS-to-FPGA user 2 clock
Originates from h2f_user0_base_clk which is the SDRAM PLL: C5 output
Refer to Figure 4.2.4.2
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4.2.4  Configure SDRAM (The HPS External Memory Interface)

Please note that Altera has an 8 Hour class available for Implementing, Simulating, and Debugging External Memory Interfaces

and this resource should be utilized for an in depth understanding of EMIFs.

Under the SDRAM tab, there are options to set the SDRAM parameters for the HPS External Memory Interface. The SoCKit has
two Micron 1.35V DDR3L SDRAM devices connected to the HPS (256Mb x 16 x 2 = 1GB at 1.5V vs. 1.35v).

There are four tabs for the SDRAM configuration: PHY Settings, Memory Parameters, Memory Timing, and Board Settings.

Select the PHY Settings tab, the clock and Advanced PHY Settings are required.

Change the memory clock frequency from 300 MHz to 400 MHz (as shown in Figure 4.2.4.1). This is the rate for the Micron
memory devices.

Verify that the supply voltage is set to be 1.5V V DDR3. The 1.35 V variation of this Micron device is used; but the Vdd/Vddq
are connected to 1.5v in order to reduce the system power supply complexity for SoCKit.

The settings should now look like:

System: soc_system Path: hps_0

Arria V/Cyclone V Hard Processor System

altera_hps

| FPGA Interfaces | Peripheral Pins | HPS Clocks| SDRAM |

-

SDRAM Protocol: [ppRz

PHY Settings | Memory Parameters I Memaory Timing I Board Settings

[~ Clocks
Memory dock frequency: 333.0 MHz

[7] Use specified frequency instead of calculated frequency
Achieved memory dock frequency: |332,554545 MHz
PLL reference dodk frequency: 25.0 MHz

|~ Advanced PHY Settings

Supply Voltage: L5VDDR3 v
1/0 standard: 55TL-15
Figure 4.2.4.1
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SORAM | ddr_das_base_dk »| ClockGate
PLL
R ddr_2x_dqgs_base_clk p| Clock Gate
o ddr_dq_base_clk p ClockGate
@G —» Unused
4 —» Unused
h2f_user2_base_clk
5 _Wele_Ddx_ P (lock Gate

Figure 4.2.4.2

— ddr_dqs_clk
— ddr_2x_dqgs_dk

— ddr_dq_dk

——» h2f _user2_clock

Select the Memory Parameters tab (as shown in Figure 4.2.4.2). The settings are needed to match the DDR3 device. A table

from the Micron datasheet shows the row address, bank address and column address. The Micron memory used on this

board has the parameters in the last column (256 Meg x 16).

4Gb: x4, x8, x16 DDR3L SDRAM

Acron

SoCKit HW Lab Instructions, Version 14.1

Description

Table 2: Addressing

Parameter 1Gigx 4 512 Meg x 8 256 Meg x 16

Configuration 128 Meg x 4 x 8 banks 64 Meg x 8 x 8 banks 32 Meg x 16 x 8 banks

Refresh count 8K 8K 8K

Row address 64K (A[15:0]) 64K (A[15:0]) 32K (A[14:0])

Bank address 8 (BA[2:0]) 8 (BA[2:0]) 8 (BA[2:0])

Column address 2K (A[11, 9:0]) 1K (A[9:0]) 1K (A[9:0])

Page size 1KB 1KB 2KB

Figure 4.2.4.2
The datasheet also shows that the DM and DQS# pins are enabled.
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NN\OW ABERA. L LN Five Years Out



Build the Qsys System

Verify the parameters that are selected as shown below:

FPGA Interfaces | Peripheral Pin Mutiplexing | HPS Clacks| SDRAM |

SDRAM Protocol: [DDR3 -

PHY Settings | Memory Parameters | Memory Timing | Board Settings|

Apply device presets from the preset list
Memory vendor: [
Memory format:

Memory device speed grade:
Total interface width:
Number of DQS groups:
Mumber of chip selectidepth expansion: |
Number of clocks: .
Row address width:
Column address width:

Bank-address width:
Enable DM pins
DQS# Enable

Figure

Apply memory parameters from the manufacturer data sheet

on the right.

Micron -

Discrete Device

8000~ |MHz

32
4

4243

The Memory Initialization Options are at the bottom of this page, where the values are again taken from the Micron

datasheet.

SoCKit HW Lab Instructions, Version 14.1

|' Memory Initialization Options

Wirror Addressing: 1 per chip select: [

Address and command parity
Mode Register 0
Burst Length:
Read Burst Type:
DLL precharge power down:

Wemory CAS latency setting:

Mode Register 1
Output drive strength setting:
Wemory additive CAS latency settin

ODT Rtt nominal value:

Mode Register 2

Auto selfrefresh method:
Selfrefresh temperature:

Wemory write CAS latency setting:
Dynamic ODT (Rit_WR) value:

Figure

N\NOW  /ADERE, L LR

:Burst chop 4 or & (on the fly} v:
:S&qu&ntial v:

DLLoff =

11

RZOT -
o |Disabled v
RZO4 v

:Manual v:
jNurmaI vi

8-

RzOM -

4.2.4.4

Five Years Out
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Under the Memory Timing tab, timing parameters need to be verified:

| PHY Settings | Memaory Parameters | Memery Timing | Board Settings

1S (base):
tH (base):

D00
tQH:
tDOSCK:
tDQSS:
HOSH:
tD5H:
055:
HIMIT:
MRD:
RAS:
tRCD:
tRP:
REFT:
tRFC:
tWR.
PWTR.:
HFAW:
tRRD:
tRTP:

D5 (base):
tDH (base):

130
140
30
65
125
0.38
255
0.25
0.4
0.2
0.2
500

35.0
13.75
13.75
7.8
2680.0
15.0

30.0
7.5
7.5

Apply timing parameters from the manufacturer data sheet
Apply device presets from the preset list on the right.

ps
ps
ps
ps
ps
cycles
ps
cycles
cydes
cycles
cycles
us
cydes
ns
ns
ne
us
ns
ne
cydes
ns
ns

ns

Figure 4.2.4.5

The memory timings listed above match those in the datasheet.

SoCKit HW Lab Instructions, Version 14.1
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Under the Board Settings tab:

Verify that the "Setup and Hold Derating" is set to Use Altera's default settings.

Verify that the Intersymbol interference should be left as default to Use Altera's default settings.

[* setup and Hold Derating

The slew rate of the output signals affects the setup and hold times of the memaory device,

You can spedify the slew rate of the output signals to refer to their effect on the setup and hald times of
both the address and command signals and the DQ signals, or specify the setup and hold times directly.

Derating method: @) Use Altera's default settings
~ Specify slew rates to calculate setup and hold times

"1 Spedfy setup and hold times directly

CKfCK# slew rate (Differential): 2.0 Vjns
Address and command slew rate: 1.0 V/ns
DQS5/D0Ss# slew rate (Differential): 2.0 Vjns
DQ slew rate: 1.0 Vjns
5 0.33 ns
tH: 0.24 ns
D5 0.13 ns
S 0.165 ns

|' Channel Signal Integrity

Channel Signal Integrity is a measure of the distortion of the eye due to intersymbol interference
ar crosstalk or other effects, Typically when going from a singlerank configuration to a multi-rank
configuration there is an increase in the channel loss as there are multiple stubs causing
reflections. Please perform your channel signal integrity simulations and enter the extra channel

uncertainty.
Derating Method: @) Use Altera's default settings
1 Spedify channel uncertainty values

Address and command eye reduction (setup): 0.0 ns

Address and command eye reduction (hold): 0.0 ns

Write DQ eve reduction: 0.0 ne

Write Delta DQS arrival time: 0.0 na

Read DQ eye reduction: 0.0 ne

Read Delta DQS arrival ime: 0.0 s

Figure 4.2.4.6
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Since the board design is complete, the board skews, which are linked to timing differences between traces are known. These

settings should be

[~ Board Skews

PCE traces can have skews between them that can cause timing margins to be reduced. Furthermare
skews between different ranks can further reduce the timing margin in multi-rank topologies.

[ Restore default values ]

Maximum CK delay to DIMM/device:

Maximum DQS delay to DIMM/device:

Minimum delay difference between CK and DQS:
Maximum delay difference between CK and DQS:

Maximum skew within DQS group:
Maximum skew between DQS groups:
Average delay difference between DQ and DQS:

Maximum skew within address and command bus:

0.03
0.02
0.09
0,16
0.01
0.08
0.0

0.03

Average delay difference between address and command and CK: (g,

Figure 4.2.4.7

ns

ns

ns

ns

ns

ns

ns

ns

ns

set to:

At the top of the Arria V/Cyclone V Hard Processor System Parameters Window, close the window by selecting the X, as the

settings for the Hard Processor System are now configured.

J@ Parameters‘ 53'

soc_system = hps_0

Arria V/Cyclone V Hard Processor System

altera_hps

[~ Board Skews

Restore default values

Maximum CK delay to DIMM,device:

Maximum DQS delay to DIMM/device:

Minimum delay difference between CK and DQ5:
Maximum delay difference between CK and DQS:
Maximum skew within DQS group:

Maximum skew between DQS groups:

Average delay difference between DQ and DQS:

Maximum skew within address and command bus:

0.03
0.02
0.09
0.16
0.01
0.08
0.0

0.03

Average delay difference between address and command and CK: |50

Figure 4.2.4.8

SoCKit HW Lab Instructions, Version 14.1
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PCE traces can have skews between them that can cause timing margins to be reduced. Furthermore
skews between different ranks can further reduce the timing margin in multi-rank topologies.
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In the export column associated with the HPS_0, there are five signals that need to be exported to the top level of the project.
This is the reason why there are five signals already associated as shown in Figure 4.2.4.9 below.

Address Map 2% | InterconnectRRequirements &3 | Device Family &2 |

AF |Use  Conmections MName Description Export Clock

b 4 = hps_0 Arria V/Cydone V Hard Processor System

E:: s f2h_cold_reset_req Reset Input hps_0_f2h_cold_reset_req

5 - f2h_debug_reset_req Reset Input hps_0_f2h_debug_reset_req

= - f2h_warm_reset_req Reset Input hps_0_f2h_warm_reset_

rY CH f2h_stm_hw_events Conduit hps_0_f2h_stm_hw_events

- A memory Conduit memaory
A hps_io Conduit hps_0_hps_io

= H h2f_reset Reset Output hps_0_h2f_reset

? f2h_sdram0_dock Clock Input clk_0
f2h_sdram0_data Avalon Memory Mapped Slave [f2h_sdram0_clock]
h2f_axi_clock Clock Input clk_0
h2f_axi_master AXI Master [h2f_axi_dock]
f2h_axi_dock Clock Input clk_0
f2h_axi_slave AXI Slave [f2h_axi_cock]
h2f_lw_axi_dock Clock Input clk_0

{ h2f_lw_axi_master AXI Master [h2f_lw_axi_clock]
f2h_irqD Interrupt Receiver
[ f2h_irgl Interrupt Receiver
Figure 4.2.4.9

Add and configure FPGA Peripherals

The next step is to add and configure the FPGA peripherals in Qsys.

4.2.5 Configure LED PIO

The SoCKit board has four LEDs connected to the FPGAs I/O pins. These LEDs are driven with an output PIO component.

To add this component

e Type PIO in the Search Window
e Double click on the PIO (Parallel I/0O) to add to your system:

- = o [
x@| %
Project if
.l New Component e
Library .I
[=]-Processors and Peripherals
=}-Peripherals -~
i@ PIO (Parallel /O) 7
=
Y
Figure 4.2.5.1
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e Set the Width to be 4, which is the number of LEDS on the board connected to the FPGA I/O pins.
e Insure that the direction is set to Output.
e Select Finish (as shown in Figure 4.2.5.2)

A& PIO (Parallel 'O) - pio 0

s

Megators’ altera_avalon_pio

R PIC (Parallel 1/0)

[~ Block Di:

[] Show signals

pio_0

LS

|~ Basic Settings

Width (1-32 bits): 4
Direction: ) Bidir
() Input

(@) InCut

Presets for pio_0

b

Project
~-Click New... to create & preset.
Library
Mo presets for PIO (Parallel 1/0) 14.1

@ Dutput

I Output Port Reset Value:! | 0y0000000000000000
xternal_connection .

[ output Reg |
[ Enable individual bit setting/cearing

altera_aval

[~ Edge capture register |

Synchronously capture

Edge Type: RISING

Enable bit-clearing for edge capture register

|~ Interrupt
Generate IRQ
IRQ Type: LEVEL

Level: Interrupt CPU when any unmasked I/0 pin is logic true
Edge: Interrupt CPU when any unmasked bit in the edge-capture
register is logic true. Available when synchronous capture is enabled

| Test bench wiring
Hardwire PIO inputs in test bench

Apply Update... Delete

Drive inputs to: 0:0000000000000000 [

Figure 4.2.5.2

Change the default name of the PIO component to be led_pio.

e To change the name, select the component (High Light), right click and select Rename.

Since the LEDs connections will be driven by the FPGAs I/O, the LED signals will need to be exported to the top level of the
project. To do so:

o Double click in the export column associated with the external connection of the led_pio and the following
should automatically show up: led_pio_external_connection. If not, then type: led_pio_external_connection

The component should now look like:
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B led_pio
clk
reset
51

external_connection

4.2.6 Configure Button PIO

P10 (Parallel 1j0)

Clodk Input

Reset Input

Avalon Memary Mapped Slave

led_pio_external_connection

Figure 4.2.5.3

wnconnected
[clk]
[clk]

The SoCKit has four push buttons that are connected to the FPGA. The PIO peripheral will be configured as an Input and will
be used to read in the push buttons connected to the FPGAs I/0.

To add the 4 input component:

e type PIO in the Search Window
e double click on the PIO (Parallel I/O) to add to your system:

A& Qsys - soc_system.gsys* (C:\altera\13.1\embeddec

Fie Edt System View Tools Help

Component Library System Conte
, PO 31| [ | Vae

. v

Project a(
¥ New Component =7
Library -—
-)-Peripherals s
=}-Microcontroller Peripherals o
2 PIO (Paraliel VO) 4
=z
o

Figure 4.2.6.1

o Set the width to be 4. Ensure that the direction is set to Input.

e Set the Edge capture register to Synchronously capture on the FALLING edge.

e Enable Generate IRQ. Set the IRQ Type to Edge.
o Refer to Figure 4.2.6.2 before proceeding to check your settings

e Select Finish

SoCKit HW Lab Instructions, Version 14.1
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& PIO (Parallel /0) - pio_0 (=5
%&  PIO (Parallel 1/O)
Megotors:  ltera_avalon_pio
~ Block Diagram
" | |~ Basic Settings |
[F] Shaw signalz Width (1-32 bits): 3
— Direction: @ Bidir
pio_0 z
@ Input
o — intermupt ) nOut
eset -
) Qutput
i Output Port Reset Value: | nx0000000000000000

"
xternal_connection
(conduit -
[* output Register \
hera_aval
Qe Enable individual bit setting/dearing

|~ Edge capture register |
Synchronously capture

Edge Type: FALLING »
[] Enable bit-dearing for edge capture register

|~ Interrupt
Generate [RQ
RQ Type: EDGE +

Level: Interrupt CPU when any unmasked I/O pin is logic true
Edge: Interrupt CPU when any unmasked bit in the edge-capture
register is logic true. Available when synchronous capture is enabled

|~ Test bench wiring
[ Hardwire PIO inputs in test bench

Drive inputs to: 0x0000000000000000

4 . | +

(@ Info: pio_0: PIO inputs are not hardwired in test bench. Undefined values will be read from PIO inputs during simulation.

Figure 4.2.6.2

Change the default name of the PIO component to be button_pio. To change the name, select the component
(high light), right click and select Rename.

Since the Button PIO connections will be inputs to the FPGAs 1/O, the Button signals will need to be exported to the
top level of the project.

e Todo so, double click within the export column associated with the external connection of this component.
o The following should automatically show up: button_pio_external_connection. If not, then type:
button_pio_external_connection

The settings for the component should now look like:

E button_pio PIO (Parallel 1/0)
dk Clock Input unconnected
reset Reset Input [clk]
51 Avalon Memory Mapped Slave [clk]
external_connection Conduit button_pio_external_connection
Figure 4.2.6.2
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Save the Qsys system, select: File -> Save.
Review other Qsys components

There are many other components in the Qsys system that have already been configured. These components have already
been configured for the SoCKit embedded system. Therefore, these components do not need to be configured.

A summary of these components:

The FPGAs array provides on chip memory blocks that can be used to build up internal RAM (or ROM) blocks of memory that
is available for any Master in the Qsys system. This provides the HPS Cortex-A9 MPU access to very low-latency, high speed
memory for code or variable storage. This is the onchip_memory2_0 component.

The JTAG to Avalon Master accepts encoded streams of bytes of transaction data on the JTAG interface and initiates Avalon-
MM (multi-master) transactions on the Avalon-MM interface. The JTAG to Avalon Master is also used for debugging, with
tools such as System Console and SignalTap. Both System Console and SignalTap will be used later in this workshop.

The System ID peripheral is a very important peripheral to include in your system. It allows the software development tools
to validate that the software application is being built for the correct hardware system. Basically, it will not allow software to
be executed on an incompatible hardware configuration.

The SoCKit has four DIP switches on it that are connected to the FPGAs I/O pins. The dipsw_pio is an input PIO peripheral
that is used to read in the DIP Switch settings in a fashion similar to the button_pio peripheral.

Software developers need to have access to a debug serial port from the target to leverage printf debugging, input control
commands, log status information, etc. The jtag_uart peripheral connects to the debugger console and provides an interface

to the developers console for that and other purposes.

Interrupts are signals that need immediate attention. Interrupts have higher priority than other processes. The
interrupt_capturer component is an Avalon Memory Mapped module (written in Verilog) to capture system interrupts and
pass them on to the HPS Cortex-A9 MPU.

4.3 System Configuration

4.3.1  Connect HPS interfaces to FPGA Peripherals

The Qsys components that were just created (led_pio and button_pio) have not been connected; therefore, there are errors.
These errors will be removed in the next steps.
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Type Path Message
=[] 4 Errors
(3 | soc_system.led_pio led_pio.clk must be connected to a dock output
g soc_system.button_pio|button_pio.clk must be connected to a dock output
a soc_system.led_pio led_pio.reset must be connected to 5 reset source
a soc_system.button_pio|button_pio.reset must be connected to & reset source

Figure 4.3.1.1

The following steps will connect the components to the system; these include the Avalon Memory Mapped signals as well as
the clock and reset signals. There are two methods that can be utilized to connect your new system components. Visually by
using the patch panel to connect the nodes or busses (dots) or by right clicking on the menu (as described below).

To connect the led_pio to the system via the menu method: right click on the clk signal of the led_pio. The available
connections are connected as shown:

— dk_reset
L || _ 1 "
ol - . .
reset Connections: led_pic.clk
sl _ clic_0.clke [ck]
<H external_connection 7 Filter o g T \ction
B button_pio
dk 3 Edit. Ctrl+E unconnected
reset Jb Add.. [dk]
sl y, [ck]
< external_connection Rename Ctrl+R button_pio_external_connection
irg Duplicate Ctrl+D [clk]
Remove 1
Details L4
Set Design Environment L4
®e
Show Arbitration Shares
wclk must be connected to a dock output v | Allow Connection B

Figure 4.3.1.2

o Select clk_0.clk

The clock of the PIO is now connected to the 100 MHz clock from the FPGAs dedicated clock input pin AF14.

The following connections will be made with the same process of right clicking on the signal and then selecting the signal to
be connected. The following table describes what signals are to be connected together
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Name of Component Name of Signal What component that What signal of the
the signal is to be component that is to be
connected to connected to

led_pio Clk clk O clk

led_pio reset clk O clk_reset

led_pio sl fpga_only_master master

led_pio sl mm_bridge_0 mO0

button_pio clk clk O clk

button_pio reset clk O clk_reset

button_pio sl fpga_only_master master

button_pio sl mm_bridge_0 mO
Table 4.3.1.1

As the connections are made, the errors at the bottom of the Qsys window will be removed. Since the IRQs have yet to be set
there will still be errors and they will be removed in the next section.

4.3.2 Set IRQs

Components with interrupts can be set to have higher priority than other system components; therefore, the components
with interrupts our Qsys system need to be assigned.

The DIP switch, button and JTAG all have interrupts that will be captured by the interrupt capture module. These interrupts
will be connected to the HPS component. The dipsw_pio and jtag_uart components already have the interrupts assigned to
them.

The pio_button component also needs to have an IRQ assigned to it.
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To assign IRQ, first the push button needs to connected to the IRQs and then the interrupts level needs to be assigned.

e Right click on the irq of the button_pio so that the button_pio irg can be selected, as seen in the following

screenshot.
s1 Avalon Memory Mapped Slave - - . ! B
o e TR Conduit Connections: button_pio.irg Export as: button_pio_irg
E button_pio P10 (Parallel 1jO) . hps_0.f2h_irg0
dk Clock Input T Filter hos 0.£2h irgl
reset Reset Input ) oSl
N N S s1 Avalon Memory Mapped Slave 2 Edit. Ctrl+E intr_capturer_0.interrupt_receiver
external_connection Conduit 2p  Add...
# Rename Ctrl+R
Duplicate Ctrl+D
X Remove
Message - Details 4
Set Design Environment 4
_axi_master |led_pio.s1 (0x0..0xf) overlaps button_pio.s1 (0x0..0xf) ShoAD e Share
aster.master |led_pio.s1 (0x0..0xf) overlaps onchip_memory2_0.s1 (0x0..0xffff)
-f LN TP DT S
Figure 4.3.2.1

e Select the hps0.f2h_irq0 so that this interrupt is selected.
e Repeat this step again, but now select the intr_capturer_0.interrupt_receiver.
The interrupts should now look like:

l E button_pio PIO (P Connections: butten_pio.irg Export as: butten_pio_irg
¢ dk Clock _ hps_0.2h_irg0
reset Reset ? Filter )
s1 Awvalor hps_0£2h_irgl 0x0000_0000
external_connection E3  Edit.. Ctrl+E intr_capturer_{.interrupt_receiver
& Add..
ﬁ Rename Ctrl+R
Duplicate Ctrl+D
Message X Remove
=| Details 4
si »
_axi_master |led_pio.s1 (0x0..0xf) overlaps button_pio.s Set Design Environment
ister.master|led_pio.s1 (0x0..0xf) overlaps onchip_mem Show Arbitration Shares
ister.master | button_pio.s1 (0x0..0xf) overlaps led_pio.s
v Allow Connection Editing
System ID is not assigned automatically. Edit the & Lock Base Address
Time stamp will be automatically updated when

" Figure 4.3.2.2

Next, verify the interrupt level for the push button.

o Select the IRQ column (second to last column in the Qsys), where the level of the IRQ that will be assigned.
e Click in the box and type in the number 1.
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- Sl _LunneLuun L ICu_pru_calcinan_uunncuinn
J E button_pio PIO (Parallel I/0)
- dk Clock Input clk_0
reset Reset Input [clk]
_ 51 Avalon Memory Mapped Slave [ck] 0x0000_0000 0x0000_000£
- external_connection Conduit button_pio_external_connection

Interrupt Sender Double-click to export

Figure 4.3.2.3
Errors still remain at the bottom of the Qsys screen and these will be removed in the following steps.

4.3.3 SetBase Addresses

The system has a memory map. A systems memory map consists of addresses that are assigned to a component and these
address ranges cannot overlap. The addresses can be assigned automatically or manually. For this workshop, the addresses
are assigned manually since the software portion of this workshop will use these addresses.

To assign base addresses:

e Select the Address Map tab in Qsys. This is a table that includes all of the memory -mapped slaves in the
design and the address range that each connected memory-mapped master uses to address that slave. The
blank cells, which are by default, implies that there is no connection between that master and slave.

The "Address Map" tab is seen as:

[System: soc_system  Path: button_pio.irg

f2sdram_only_master master fpga_only_master.master hps_0.h2f_axi_master hps_0.h2f_Iw_axi_master hps_only_master.master mm_bridge_0.m0
dipsw_pio.s1 0x0001_0080 - 0x0001_008£ 0x0001_0080 — 0x0001_008£
hps_0.f2h_sdram0_data 0x0000_0000 - OxEfff £iff
hps_0.f2h_axi_slave 0x0000_0000 - Ox£fff fiff
intr_capturer_0.avalon_slave_0 0x0003_0000 - 0x0003_0007
tag_uart.avalon_jtag_slave 0x0002_0000 - 0x000%_0007 0x0002_0000 - 0x0002_0007
mm_bridge_0.s0 0x0000_0000 - 0x0003_£Iff
nchip_memory2_0.s1 0x0000_0000 - 0x0000_££££ 0x0000_0000 — 0x0000_££££
cysid_qsys.control_slave 0x0001_0000 - 0x0001_0007 0x0001_0000 - 0x0001_0007
ed_pio.s1 0x0001_0040 - Ox0001_004f 0x0001_0040 - 0x0001_004£
button_pio.s1 0x0001_00c0 - 0x0001_00cf 0x0001_00e0 — 0x0001_00cE
onchip_memory2_0.s1 via mm_bridge_0 0x0000_0000 - 0x0000_£££2
jtag_uart.avalon_jtag_slave viamm_b... 0x000Z_0000 - 0x0002_0007
dipsw_pio.s1 via mm_bridge_0 0x0001_0080 - 0x0001_008£
button_pio.s1 via mm_bridge_0 0x0001_00c0 - 0x0001_00cE
led_pio.s1 via mm_bridge_0 0x0001_0040 - 0x0001_004F
sysid_gsys.control_slave via mm_bridg... 0x0001_0000 - 0x0001_0007

Figure 4.3.3.1

Now all of the errors in your Qsys system should be eliminated!
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Once these values are entered, go back to the System Contents tab and go the led_pio and select the row associated with the
base addresses, as shown below.

In the Base address column, select the lock icon by the Base Address, so that the Base Address is locked, as seen below.
Locking an address prevents a base address from being changed.

= led_pio
dk
reset
51
external_connection
E button_pio
dk
reset
s1
external_connection
irg

Lolll oll]

4.34

PIO (Parallel I/0)

Clock Input

Reset Input

Avalon Memory Mapped Slave
Conduit

PIO (Parallel 1/0)

Clock Input

Reset Input

Avalon Memory Mapped Slave
Conduit

Interrupt Sender

Set AXI Bridge to Secure

led_pio_external_connection

button_pio_external_connection

clk_0
[dk]
[ck]

clk_0
[ck]
[dk]

[ehk]

Figure 4.3.3.4
Repeat the same step for button_pio so that its address range is also locked.

7

] rfofJOl_OfJ‘lfJ
( ] Fxﬂﬂﬂl_ﬂﬂcﬂ

0x0001_004f

0x0001_00ef

The system has three JTAG to Avalon Master bridges and in Module 5 we want to allow system console the ability to Write to
the HPS memory space from the FPGA. Specifically, to the HPS GPIO’s (GPIO53, GPI054, GPIO55 & GPI056) associated with
the LEDs on pins: A24, G21, C24 and E23. | order for the system to allow this capability, the hps_only_master.master port

must be set to secure.

In Qsys select and right mouse click on “Connections”, a drop down dialog box will appear as shown in Figure 4.3.4.1

Check “Show Security Column”.

1 system Contents £

AddressMap

Interconnect Requirements 1%

Device Famiy %

| use
x

Connections

=
a
v

=

<« MR RIRIRIAS

Y

Show Use Column

Name

asys

Show Connections Column

Show Description Column

Show Clock Column
Show Base Column
Show End Column

Show Export Column

|_slave

¥d_reset_req
sbug_reset_req
arm_reset_req
m_b_events
v

Show Auto Export Column

Show Tags Column

Show Security Column
Show Default Slave Calumn

Show Opcode Name Column

Show IRQ Column
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set
Iramo_dock
Iram_data
ti_dock
ii_master
fi_clock
_ i_siave
haf_lw_axi_clack
haf_lw_axi_master
f2h_irg0
f2h_irq1
B hps_only_master
dk
ck_reset
master
master_reset
B fpga_only_master

LINEAR

TECHNOLOGY

Deseription
System ID Peripheral

(Clock Input

Reset Input

valon Memory Mapped Slave
Arria V/Cycione V Hard Processor System
Reset Input

Reset Input

Reset Input

Condit

Candit

Condit

Reset Output

Clack Input

valon Memory Mapped Slave
Clack Input

AT Master

(Clock Input

A1 Slave

(Clock Input

AXI Master

Interrupt Receiver

Interrupt Receiver

ITAG to Avalon Master Eridge
(Clock Input

Reset Input
Avalon Memory Mapped Master
Reset Output

TTAG to Avalon Master Eridge

Export Clock

dk_0
[ck]
[clk]

hps_0_f2h_cold_reset_r..|
hps_0_f2h_debug_reset..
hps_0_f2h_warm_reset...
hps_0_f2h_stm_hw_ev...
memory

hps_0_hps_io
hps_0_h2f_reset

dk_o
[f2h_sd
dk_o
[haf e
dk_0
[f2h_an
ck_0
Thaf w

clk_0

Double-lick to export _[dk]
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Figure 4.3.4.1
The “Security” Column will now be available in Qsys:
| Name Description Export Clock Base End
E sysid_gsys System ID Peripheral
dk Clock Input clk_0
y——> reset Reset Input [ck]
control_slave Avalon Memory Mapped Slave [clk] @ 0x0001_0000 0x0001_0007
E hps_0 Arria VfCydone V Hard Processor System
(ma) f2h_cold_reset_reg Reset Input hps_0_f2h_cold_reset _r...,
C— f2h_debug_reset_req |[Reset Input hps_0_f2h_debug_reset...,
e f2h_warm_reset_req  |Reset Input hps_0_fZh_warm_reset...
< f2h_stm_hw_events Conduit hps_0_f2h_stm_hw_ev...
L] memory Conduit memory
Lt hps_io Conduit hps_0_hps_io
=2 haf_resst Reset Output hps_0_h2f_reset
f2h_sdram0_clock Clock Input clk_0
f2h_sdram0_data Avalon Memory Mapped Slave [fzh_sdram... 0x0000_0000 QufEEE_fEEE
h2f_axi_cock Clock Input clk_0
h2f_axi_master AXI Master [h2f_axi_do...
f2h_axi_dock Clock Input clk_0
f2h_axi_slave AXI Slave [f2h_axi_do... 0x0000_0000 Ox£EEE EEEE
h2f_lw_axi_clock Clock Input clk_o
h2f_lw_axi_master AXI Master h2f lw_axi...
f2h_irqd Interrupt Receiver IRQ O
f2h_irgl Interrupt Receiver IRQ 0
E hps_only_master JTAG to Avalon Master Bridge
dk Clock Input clk_0
— dk_reset Reset Input

Deouble-dlick te export  [dk]

master Avalon Memory Mapped Master

Figure 4.3.4.2

Select the master under “hps_only_master” and click on “Non-secure” and change to “Secure”:

ran_rgL INTErTUPT Kecelver 18Q O LHQ 31
E hps_only_master JTAG to Avalon Master Bridge

dk Clock Input clk_0

dk_reset Reset Input

master_reset
B fpga_only_master
dk Clock Input

JTAG to Avalon Master Bridge

dk_reset Reset Input

E hps_only_master IJTAG to Avalon Master Bridge
dk Clock Input
clk_reset

Double-click to export  [dk]

jizle]

master_reset

Figure 4.3.4.4

e Save the Qsys system, with File -> Save.
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T... Opcode Nam< Security >

Hon-secure

INon-secure
[TrustZone-aware
INon-secure

[TrustZone-aware

T —

' Mon-secure

)
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4.3.5 Block Diagram of the Golden Hardware Reference Design

The Golden Hardware Reference Design is an important part of the GSRD and consists of the following components:
ARM Cortex™-A9 MPCore HPS

Four user push-button inputs

Four user DIP switch inputs

Four user I/O for LED outputs

64KB of on-chip memory

JTAG to Avalon master bridges

Interrupt capturer for use with System Console

System ID

Hard Processor

ARM Cortex-A9 MPCore

System CPUO CPUT
|-Cache |D-Cache| |-Cache | D-Cache
L2 Gache DDR
Trace Memory Controller QSPI
USB OTG GPIO
Gbps Ethernet — ROM PG
SDIMMC UART
— RAMG4KB CAN
Ti
r—| FPGA Manager mers
- DMA
I 1 |
HPS-to-FPGA Lightweight FPGA-to-HPS
HPS-t0-FPGA
FPGA Fabric
On-Chip RAM E—< 8
ecuUre
FIOLED JTAG Master
PIO Button (HPS Only)

PIO DIP Switch

JTAG UART

Non-Secure
JTAG Master
(FPGA Only)

|

Interrupt Capturer
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Figure 4.3.5.1

4.3.5.1 MPU Address Map
This section presents the address maps as seen from the MPU (A9) side.
HPS-to-FPGA Address Map

The memory map of soft IP peripherals, as viewed by the microprocessor unit (MPU), starts at HPS-to-FPGAaddress offset 0xC000_0000.
The following table lists the offset of each peripheral in the FPGA portion of the SoC.

Peripheral Address Offset (Size (bytes) |Attribute
onchip_memory2_0|0x0 54K On-chip RAM as scratch pad
Table 4.3.5.1

Lightweight HPS-to-FPGA Address Map

The memory map of system peripherals in the FPGA portion of the SoC as viewed by the MPU, which starts at the lightweight HPS-to-FPGA
base address OxFF20_0000, is listed in the following table.

Peripheral Address Offset | Size (bytes) | Attribute

sysid_qgsys 0x1_0000 8 Unique System ID

led_pio 0x1_0040 8 LED output display

dipsw_pio 0x1_0080 8 DIP Switch Input

button_pio 0x1_00c0 8 Push button Input

jtag_uart 0x2_0000 8 JTAG UART console
Table 4.3.5.2

4.3.5.2 JTAG Master Address Map

There are two JTAG master interfaces in the design, one for accessing non-secure peripherals in the FPGA fabric, and another for accessing secure
peripheral in the HPS through the FPGA-to-HPS Interface. The following table lists the address of each peripheral in the FPGA portion of the SoC, as

seen through the non-secure JTAG master interface.

Peripheral Address Offset [Size (bytes) |Attribute
sysid_gsys 0x0001_ 0000 a8 Unigue System ID
led_pio 0x0001_0040 8 4 LED outputs
dipsw_pio 0x0001 0080 8 4 DIP Switch inputs
button_pio 0x0001_00cO g8 4 push button inputs
jtag_uart Ox0001_ 0000 a8 JTAG UART console
onchip_memory2 0 |0x0000 0000 54K On-chip RAM

SoCKit HW Lab Instructions, Version 14.1
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4.3.5.3 Interrupt Routing

Table 4.3.5.3

The HPS exposes 64 interrupt inputs for the FPGA logic. The following table lists the interrupts from soft IP peripherals to the HPS interrupt input

interface.

Peripheral Interrupt Number |[Attribute
dipsw_pio f2h_irg0[0] 4 DIP Switch Inputs
button_pio f2h_irg0[1] 4 Push Button Inputs
jtag_uart f2h_irg0[2] JTAG UART

Table 4.3.5.4

The interrupt sources are also connected to an interrupt capturer module in the system, which enables System Console to be aware of the interrupt

status of each peripheral in the FPGA portion of the SoC.

SoCKit HW Lab Instructions, Version 14.1
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44 Generate the System

Please Double-check to make sure that all the component names, clocks and base addresses in your Qsys system match the

names below.

First half of the Qsys Window

B roces v o [ stmcomectRequenens 53

x| || 1 system: soc_system  Path: onchip_memory2_0.s1

Use  Connections Name

B sysid_gsys
ok
——> reset

contraol_slave
a E hps_o
f2h_cold_reset_req

f2h_debug_reset_req

K4 bW Tl XE+

f2h_warm_reset_req
f2h_stm_hw_events
memory
hps_io
h2f_reset
f2h_sdram0_clock
f2h_sdram0_data
h2f_axi_dock
h2f_axi_master
f2h_axi_dock
f2h_axi_slave
h2f_w_axi_dock
h2f_lw_axi_master
f2h_irqd
f2h_irgl

E1 1 hps_only_master
ck
dk_reset
master
master_reset

B fpga_only_master
ck
dk_reset
master
master_reset

B0 fasdram_only_master
ck
dk_reset
master
master_reset

E mm_bridge_0
ck

——> reset

s0

e mid

RQOoPRY

SoCKit HW Lab Instructions, Version 14.1

Description

System ID Peripheral

(Clock Input

Reset Input

\Avalon Memary Mapped Slave

Reset Input

Reset Input

Reset Input

(Conduit

(Conduit

(Conduit

Reset Output

(Clock Input

\Avalon Memary Mapped Slave
(Clock Input

|AXI Master

(Clock Input

|AXT Slave

(Clock Input

|AXI Master

Interrupt Receiver

Interrupt Receiver

JTAG to Avalon Master Bridge
(Clock Input

Reset Input

\Avalon Memary Mapped Master
Reset Output

\JTAG to Avalon Master Bridge
(Clock Input

Reset Input

\Avalon Memary Mapped Master
Reset Output

JTAG to Avalon Master Bridge
(Clock Input

Reset Input

\Avalon Memary Mapped Master
Reset Output

\Avalon-MM Pipeline Bridge
(Clock Input

Reset Input

\Avalon Memary Mapped Slave

\Avalon Memary Mapped Master

\Arria V/Cydone V Hard Processor System

Export

hps_0_f2h_cold_reset_req
hps_0_f2h_debug_reset_req
hps_0_f2h_warm_reset_req
hps_0_f2h_stm_hw_events
memory

hps_0_hps_io
hps_0_h2f_reset

Figure 4.4.1
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Clock.
clk_0

[clk]
[clk]

clk_0

clk_0

clk_0

clk_0

clk_0

[clk]

clk_0

[clk]

clk_0

[clk]

clk_0
[clk]
[clk]
[clk]

[f2h_sdram...

[h2f_axi_clo...

[f2h_axi_clo...

[h2f_lw_axi...

Base

& 0x0001 0000

0x0000_0000

0x0000_0000

0x0000_0000

End

0x0001_0007

IR0 0
IR0 0

0x0003_;
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Second half of the Qsys window

E mm_bridge_0

/Avalon-MM Pipeline Bridge

Select the "Generate" from the menu and then select Generate HDL... from the drop down menu.

Next select the Generate button.
If it asks you to save, select Yes.

Figure 4.4.2

A Generation

Create HDL design files for synthesis: [yerilog |

Synthesic files are used to compile the system in a Quartus II project.

[ Create timing and resource estimates for third-party EDA synthesis tools.

Create block symbol file (.bsf)

Create simulation model:

None

Allow mixed-anguage simulation

Enable this if your simulator supports mixed-anguage simulation.

The simulation model contains generated HOL files for the simulator, and may indude simulation-only features.

|* output Directory

Path:

Cifaltera_trn/SoCKIT_Materials_14. 1/SoCkit/SoCkit_HW_Lab_14, 1/soc_system

()

dk Clock Input clk_o
> reset Reset Input [clk]
s Avalon Memory Mapped Slave [cli] 0x0000_0000 0x0003_£E££5
mo Avalon Memary Mapped Master [clk]
O jtag_uart JTAG UART
dk Clock Input clk_0
- reset Reset Input [clk]
avalon_jtag_slave /Avalon Memory Mapped Slave [clk] & 0x0002_0000 0x0002_0007
irg Interrupt Sender [dk] >—€“]—E|
3 dipsw_pio PIO (Parallel 1/C)
dk Clock Input dk_o
- reset Reset Input [ck]
sl /Avalon Memory Mapped Slave [clk] & 0x0001_0080 0x0001_00GE
o external_connection Conduit dipsw_pio_external_connect...
irq Interrupt Sender [
El onchip_memory2_0 On-Chip Memory (RAM or ROM)
dki Clock Input clk_0
Avalon Memory Mapped Slave Double-click to export 0x0000_0000 0x0000_£EFE
" resetl Reset Input [clk1]
B intr_capturer_0 Interrupt Capture Module
dock Clock Input. clk_o
— reset_sink Reset Input [clock]
avalon_slave_0 Avalon Memory Mapped Slave [dock] & 0x0003_0000 0x0003_0007
interrupt_receiver Interrupt Receiver [dock] IRD O IRD 31
O clk_o Clock Source
(=8 dk_in Clock Input clk exported
- dk_in_reset Reset Input reset
< ok Clock Output ck_o
— clk_reset Reset Output
= led_pio PIO (Parallel 1/0)
r———— dk Clock Input clk_o
— reset Reset Input [dk]
sl Avalon Memary Mapped Slave [dk] & 0x0001_0040 0x0001_004£
< external_connection Conduit led_pio_external_connection
= button_pio PIO (Parallel 1/0)
dk Clock Input clk_0
—— reset Reset Input [ck]
sl Avalon Memory Mapped Slave [dk] & 0x0001_00cO 0:0001_00cE
o external_connection Conduit button_pio_external_connec...
irq Interrupt Sender [ck) =]

Figure 4.4.3
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You will receive the following warnings, but they can be disregarded:

A Generate Completed — @

N —

", Warning: hps_0.f2h_irg0: Cannot connect dock for irg_mapper.sender
-, Warning: hps_0.f2h_irg0: Cannot connect reset for irg_mapper.sender
~, Warning: hps_0.f2h_irg1: Cannot connect dock for irg_mapper_001.sender

", Warning: hps_0.f2h_irg1: Cannot connect reset for irg_mapper_001.sender ||

I ", Generate: completed with warnings.

Figure 4.4.4
Exit Qsys by clicking: File then Exit and click Save when it asks if you would like to save the system.

Next, select: OK when the message about adding the qip and sip files to the Quartus Il project is displayed.
This will be taken care of in MODULE 5: Complete the Quartus Il Project

@.f Quartus I @

'0' You have created an IP Variation in the file

C: faltera_trnfSoCKIT _Materials_14. 1/SoCkit/SoCkit_HW _Lab_14. 1/soc_system. gsys.

To add this IP to your Quartus project, you must manually add the .gip and .sip files
after generating the IP core.

The .qgip will be located in <generation_directary =/synthesis /soc_system. gip

The .sip will be located in <generation_directory = fsimulation/soc_system.sip

Figure 4.4.5
A simulation model for the System wasn’t created; therefore, you will not find the */simulation/soc_system.sip file.

Qsys will generate the HDL files (Verilog or VHDL) for the defined system. These HDL files are then used by Quartus Il to
compile and generate a set of files that defines the hardware system. This set of files includes the HDL files, Tcl (Tool
Command Language) files that define dedicated pin locations for selected HPS peripherals, Tcl files that define the
Multiport Memory Controller in the HPS & FPGA, QIP files that include: selected IP and SDC (Synopsis Design Constraint
files) utilized by TimeQuest to constrain the complete system design, SIP files that include: the Simulation IP files
required to complete a simulation. Both the QIP and SIP files use Tcl syntax.

SoCKit HW Lab Instructions, Version 14.1 7
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In Quartus Il you can find these files here by selecting File -> Open, then go to the soc_system/synthesis directory

(select: All Files(*.*)) for all of the files to be displayed:

Open File @
Look in: | | synthesis j = |‘=_“F B~
= Name = Date modified Type Size
Py
e | submodules 2/5/2015204 PM  File folder
Recent Places . .
|| soc_system.debuginfo 2/5/2015 2:04 PM DEBUGINFO File 2,253 KB
4 [ soc_system.qgip 252015204 PM QP File 1,85 KB
Desktop || soc_system.regmap 2/5/2015 2:02 PM REGMAP File 9,017 KB
—_—— || soc_system.v 2/5/2015 2:03 PM V File 111 KB
g:T;»J || soc_system_hps_(_hps.svd 27572015 2:02 PM SVD File 9,016 KB
Libraries
P |
LY
LF4714
«
Netwarl
File: name: |subm0dules.' j Open |
Files of type: All Files (*.) hd Cancel J
[ Add file to cument project
Open as: |A|.rlo ﬂ
Figure 4.4.5

CONGRATULATIONSI!

You have just built your first Qsys system!

SoCKit HW Lab Instructions, Version 14.1
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MODULE 5. Complete the Quartus Il Project

Module Objective:

In this module you complete the Quartus Il project by adding the generated Qsys system to the top level entity. Use Quartus
Il tool to perform analysis, synthesis, fitting, place and route as well as the static timing analysis. At the end of the compilation,
an SRAM object file (*.SOF) will be generated for the FPGA. This SOF will then be downloaded to the Cyclone V SoC device via
the USB Blaster and the Quartus Il programmer.

5.1  Set up the Quartus Il project to point to the correct files

When the generate button in Qsys in the previous step was selected, Qsys generated numerous HDL (Verilog) files that will be
utilized by the synthesis tool in Quartus Il (QIS). These files need to be added to the Quartus Il project so that they can be
compiled in the next step. However, rather than adding all of the files separately, there is a single file, soc_system.qip, that
will contains the paths for all of the IP cores.

e To add this file in Quartus I, select: Assignments -> Settings -> Files and select using the "..." Browse button
" Settings - soc_system

Category:

General
Files
Libraries
4 1P Settings
IP Catalog Search Locations

Files
Select the design files you want to indude in the project. Click Add Al to add all design files in the project directory to the project.

File name:

Design Templates
4 Qperating Settings and Conditions
Voltage
Temperature
4 Compilation Process Settings
Incremental Compilation
4 EDA Tool Settings
Design Entry/Synthesis
Simulation
Formal Verification
Board-Level
4 Compiler Settings
VHDL Input
Verilog HOL Input
Default Parameters
TimeQuest Timing Analyzer
Assembler
Design Assistant
SignalTap II Logic Analyzer
Logic Analyzer Interface
PowerPlay Power Analyzer Settings
55N Analyzer

SoCKit HW Lab Instructions, Version 14.1
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File Mame Type

topfconfig_soc.v Verilog HOL File
cti_tapping.stp  SignalTap II Logic Analyzer File
topfghrd_top.v  Verilog HOL File

Library

Design Entry/Synthesis Tool
<Mone =
<Mone =
<MNone =

HDL Version
Default

Default

Figure 5.1.1
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e Next, select the system_soc.qip file (select All Files (*.*) drop down dialog to see the file)

Select File E

Organize « New folder
| 1. 50C Team i MName . Date modified Type Size
1 Altera )
| submoedules 8/4/2014 9:15 PM File folder
1. embedded_13.1 . )
140 || soc_system.debuginfo 8/5) DEBUGIMFO File 2,223 KB
- M'ZM € soc_system.qip__) 8/5/2014 204 PM  QIP File 1,841 KB
= || soc_system.regmap 8/5/2014 2:03 PM REGMAP File 9,017 KB
.. embedded )
|| soc_system.v 8/3/2014 2:03 PM V File 115 KE
I || soc_system_hps_0_hps.svd 8/5/2014 2:03 PM SVD File 9,016 KB
= Libraries

@ Documents

Jl Music

[E=] Pictures
i Videos i

File name: soc_system.qgip

e

Cancel ]

LAl 0

o 1 |

Figure 5.1.2

e Then, select "Open"

e Add the file to the project by selecting the "Add" button

e Select Apply.
A DS S

Category:

.

.

.

.

.

Select the design files you want to incdude in the project. Click Add All to add all design files in the project directory to the project.

Files
Libraries

Device...

1P Settings

IP Catalog Search Locations

File name: | soc_system/synthesis/soc_system.gip

Operating Settings and Conditions
Voltage File Name
topj/config_soc.v
top/ghrd_top.v
cti_tapping.stp

Temperature
Compilation Process Settings
Incremental Compilation
Physical Synthesis Optimizations
EDA Tool Settings
Design Entry/Synthesis
Simulation
Formal Verification
Board-Level
Analysis & Synthesis Settings
VHDL Input
Verilog HOL Input
Default Parameters
Fitter Settings
TimeQuest Timing Analyzer
Assembler
Design Assistant
SignalTap II Logic Analyzer
Logic Analyzer Interface
PowerPlay Power Analyzer Settings
S5N Analyzer

Library  Design Entry/Synthesi

<None
<None>

SignalTap II Logic Analyzer File <Mone>

[ Remove |
U

[ Do |

Properties
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ANV RVATTERAWEY @ 4

Using the same window and use the same process in the two previous steps to add the

soc_system_timi

Select File

S~

ng.sdc

|« altera tm » SoCkit HW Lab 14.0 » SoCkit HW Lab 14.0 »

Organize *  New folder
1) 140 * Name - Date modified Type Size
. M2Mm
| .gsys_edit 8/4/201410:12AM  File folder
. embedded )
L db 8/5/2014 2:16 PM File folder
| incremental_db 8/5/2014 2:15 PM File folder
4 Libraries
M ip 8/2/201412:38 PM File folder
[Z Documents e R )
J‘ o | output files 8/5/2014 2:16 PM File folder
usic
— |/ precompiled_files_for_system_console_m... 8/2/201412:38 PM File folder
[ Pictures 3
J soc_system 8/5/2014 2:32 PM File folder
B# Videos
. top 8/5/2014 1:57 PM File folder
L_| ghrd_reset.tcl 11/10/2013 2:07 PM  TCL File 4 KB
@ Homegroup K § )
| ghrd_sc_script.tel 11/10/2013 10: TCL File 16 KB
£ || Seript_to_run.tcl 8/8/201311:36 AM TCL File 1KB
18 LF4714 =
s S rstem_tim 11/28/201312:50 ...  SDC File 7 KB
&, Local Disk (C3) = — -
|| test_onetcl 12/16/2013 6:16 AM  TCL File 4 KB

€ Netwark

File name: soc_system_timing.sdc

Capce

Figure 5.1.4
Using the same window and use the same process in the two previous steps to add the
/ip/edge_detect/altera_edge_detector.v
/ip/altsource_probe/hps_reset.v
/ip/altsource_probe/hps_reset.qip
/ip/debounce/debounce.v

The window should look like:

" Settings - soc_system
Category:
Files
Libraries Select the design files you want to indude in the project. Click Add Al to add all design files in the project directory to the project.
4 1P Settings
IP Catalog Search Locations File name: ] Add
Design Templates
4 Operating Settings and Conditions File Name Type Library  Design Entry/Synthesis Toal HDL Version
Voltage ip/debounce,fdebounce. v Verilog HDL File <None Default
Temperature ip/altsource_probe/hps_reset.v Verilog HDL File <None> Default Remave
4 Compilation Process Settings ip/altsource_probe/hps_reset.qip IP Variation File (.gip) <None>
Incremental Compilation ipfedge_detect/altera_edge_detector.v  Verilog HDL File <None> Default Un
4 EDA Tool Settings soc_system_timing.sdc Synopsys Design Constraint... <None>
Design Entry/Synthesis soc_system/synthesis/soc_system.gip 1P Variation File {.qip) <None:> Down
Simulation top/fconfig_soc.v Verilog HDL File <None Default
Formal Verification cti_tapping.stp SignaTap 1T Logic Analyzer File <None> Properties
Board-Level topfghrd_top.v Verilog HOL File <None Default
4 Compiler Settings
VHOL Input
Verilog HOL Input
Default Parameters
TimeQuest Timing Analyzer
Assembler
Design Assistant
SignalTap II Logic Analyzer
Logic Analyzer Interface
PowerPlay Power Analyzer Settings
SSN Analyzer
ok || concel [ apply ][ Hed

Figure 5.1.5
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o Select Apply, Select OK

e The next step is to add the synthesis directories to the project. Quartus Il uses these files in these directories

to compile the design.

e To do this, select Assignments -> Settings -> Libraries and select in the Project Library section, with the ...

(Browse) button, the three HPS libraries.
soc_system/synthesis/
soc_system/synthesis/submodules/
soc_system/synthesis/submodules/sequencer/

e Select Add after adding each library.

The end result should look like:

r —— ™

General
Files
|Libraries | | Spedfy both project and global libraries. List the library names in the order you want to search them, Both project and global libraries can contain user-defined or
4 Operating Settings and Conditions wendor-supplied megafunctions, Block Symbol Files, and AHDL Indude Files.
Voltage
Temperature Global libraries (&l projects)

4 Compilation Process Settings Global library name: E] Add
Early Timing Estimate =
Incre.menial Cam.pi\aﬁo.n o Libraries: Remave
Physical Synthesis Optimizations

4 EDA Tool Settings Up
Design Entry/Synthesis
Simulation Down
Formal Verification
Board-Level

4 Analysis & Synthesis Settings
WHDL Input
Verileg HOL Input
Default Parameters

Fitter Settings
TimeQuest Timing Analyzer
Assembler o
Desian Assistant Project libraries
SignaTap II Logic Analyzer T
Project library name:
Logic Analyzer Interface e Y E] i
PowerFlay Power Analyzer Settings Libraries: Remove
55N Analyzer soc_systemsynthesis/
soc_system/synthesis/submodules/ Up
soc_system fsynthesis/submodules/sequencer f
Down

Figure 5.1.6
o Select Apply

e Select OK to finish.
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5.2 Analysis and Synthesis

Before the pin-outs can be added to Quartus Il an Analysis and Synthesis needs to be completed. Analysis and Synthesis is the
stage that analyzes and synthesizes design files and creates a net-list within a project database. These nets can then be
assigned to actual device pins.

e Select the icon with the checkmark (purple arrow with blue checkmark) at the top of the Quartus Il window,
as seen below.

PP OO PP AE
[ Start Anayss . Synihess |

Figure 5.2.1
e Analysis and Synthesis will now run. Once it is complete, select OK.

e There should be no errors.
e Ifthere are errors, there will be error messages at the bottom of the page that will describe the errors. These

errors will need to be resolved before continuing.

5.3 Adding Pin assignments

Since an HPS was instantiated in the Qsys system, pin assighments other than memory pins, do not need to be specified in
Quartus Il. The HPS pin assignments are automatically assigned when the HPS was instantiated and this information is
contained in the XML files, which the software development tools will utilize. However, the HPS memory pins will need to be
assigned, since there are External Memory Interface variations that can occur. This task is completed by running a Tcl script
that was created by Qsys for this purpose.
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e To run the TCL script, select Tools -> TCL scripts... and select the hps_sdram_p0_pin_assignments.tcl as seen

below.
&4 TCL Scripts @
Libraries:
4 |7 =soc_zystem - Open File
4 | synthesis
4 | submodules
hps_sdram_p0_parameters. tcl =
hps_sdram_p0_pin_assignments. tcd
hps_sdram_p0_pin_map.tc
hps_sdram_p0_report_timing. tcl
hps_sdram_p0_report_timing_core. td
hos sdram o0 timing. td i
Preview:
# (C) 2001-2014 Altera Corporation. All rights reserved. <
# Your use of Altera Corporation's design tools, logic functions and other
# software and tools, and its AMPP partner logic functions, and any output
# files any of the foregoing (induding device programming or simulation
# fileg), and any assodated documentation or information are expressly subject
# to the terms and conditions of the Altera Program License Subscription
# Agreement, Altera MegaCore Function License Agreement, or other applicable
# license agreement, induding, without limitation, that your use is for the
# sole purpose of programming logic devices manufactured by Altera and sold by
# Altera or its authorized distributors. Please refer to the applicable
# agreement for further details.
4 n »
Run ] | Close | | Help

Figure 5.3.1
o Select Run.
e Select Close after the TCL script states that it has correctly added pins.

5.4 Compile (Optional step for this lab)

At this point the design is ready for compilation.

Since a full compilation can take a while, depending on the computer being used, there are precompiled files available which
will be used in Module 6.

The generated file is: soc_system.sof
To complete a full compilation, select: Processing -> Start Compilation. There should be no errors in the compile, and you
should see the successful completion dialog when it is finished. You will see some warnings related to the files from the

automatically generated system, missing assignments/features and incomplete pin assignments but these will not affect the
functionality of the system.

The output of the compilation is a SOF file entitled “soc_system.sof” which you can find in the output_files directory:
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.. » LF4714 » Local Disk (C:) » altera_trn » SoCKit » SoCKit_ HW_lab_131 » output_files

Organize * | |Open  Bum  New folder o @ |
P 4 Name ° Date modified Type Size
M Desktop | soc_system.asm.rpt 12/14/20139:33 AM  RPT File 8 KB
| 8 Downloads _| soc_system.done 12/14/20139:34 AM DONE File 1KB
‘2:] Recent Places _| soc_system.eda.rpt 12/14/20129:34 AM  RPT File 6 KB
2 130sp1 | soc_system.fit.rpt 12/14/20129:32 AM  RPT File 1E01 KB
4# Dropbox _| soc_system.fit.smsg 12/14/20129:32 AM  SMSG File 1KB
& 131 L _| soc_system.fit.summary 12/14/2013 9:32 AM  SUMMARY File 1KB
1. 50CTeam | [ soc_system.flow.rpt 12/14/20139:34 AM  RPT File 55 K8
. Altera | soc_system.jdi 12/14/20139:33 AM  IDIFile 38BKB
1. embedded _| soc_system.map.rpt 12/14/20139:29 AM  RPT File 3244 KB
[ soc_system.map.smsg 12/14/20139:29 AM  SMSG File 4K8B
4 Libraries || soc_system.map.summary 12/14/20139:29 AM  SUMMARY File 1KB
[Z] Documents [ soc_system.pin 12/14/20139:32 AM  PIN File 117 KB
o Music | soc_system.sof 12/14/20139:33 AM  SOF File 7,208 KB
[&] Pictures | soc_system.sta.rpt 12/14/20139:34 AM  RPT File 12,125 KB
' Videos _| soc_system.sta.summary 12/14/2012 9:34 AM  SUMMARY File 10 KB
& Homegroup
y  soc_system.sof Date modified: 12/14/2013 9:33 AM Date created: 12/9/2013 2:25 PM
J SOF File Size: 703 MB

Figure 5.4.1
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Hardware Debug Flow (System Console)

MODULE 6. Hardware Debug Flow (System Console)
Module Objective:

In this module you will debug the Qsys system by utilizing system console. We will execute a Tcl script in the system console
tool to write data to the LED_PIO port. The Tcl script sets up the JTAG Master port in the Qsys system and then provides
stimulus to write successive bytes of data to the LED_PIO port.

6.1 Downloading and Programming FPGA

Previously, when the USB Blaster driver was enabled, the SoCKit was plugged in, the programming dip switch was enabled
and the cables were connected, ensure that the SoCKit is still powered on, and cables are still connected.

e  Within Quartus I, select Tools -> Programmer. OR Launch the Quartus Il v14.1 software: Select E -> All
Programs -> Altera 14.1.0.186 Web Edition -> Quartus Il 14.1 Programmer

e Select i - (top left hand side of the Programming Window) and ensure that the currently selected
hardware is CV SoCKit [USB-1]. It should be selected by default. If not currently selected; then double click
on CV SoCKit.

- ~
\‘.h Hardware Setup Iﬁ
Hardware Settings JTAG Settings

Select a programming hardware setup to use when programming devices. This programming
hardware setup applies only to the current programmer window.

Currently selected hardware: ICV SolCKit [USB-1] - J
I Available hardware items
Hardware Server Port Add Hardware. ..
I CV SoCKit Local USB-1 =

Close

Figure 6.1.1
® Select Close.
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Hardware Debug Flow (System Console)

e Select "Auto Detect"

W Programmer - C:/Altera_trn/SoCKIT/SoCKIT_HW_lab_131/soc_system - soc_system - [output_files/soc_system.cdf] El
Ele Edit View Processng Tools Window Help 5 Search altera.com @
&, Hardware Setup....| Cv socKit [USB-1] Mode: [ITAG v Progress: ]
(7] Enable real-time ISP to allow background programming (for MAX TI and MAX V devices)
File Device Checksum Usercode Program/ Verify Blank- Examine Security
Configure Check Bit
output_filesfsoc_system.... SCSXFC6D6F31CSES 026EDBD4 026ED8D4 B
"L,' Change File.. - = .
s} Save File =
fihup =
DI 3
ﬂl‘ﬂ Down )
SCSXFCEDEF3IES
Fi mo -
Figure 6.1.2
e Select the correct device: "5CSXFC6D6ES" and then OK
\'ﬁ Select Device @
Encounter devices with shared JTAG ID for device 1. Please select your device.
() SCSEBAG
() SCSEBABES
() SCSYFCECE
(") SCSXFCECSES
™) SCSXFCEDA
@ SCSXFCSDSES
Figure 6.1.3
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o If the following appears, Select Yes:

M

} The auto-detected device chain does not match the Programmer's device list. Do you
i want to update the Programmer's device list, overwriting any existing settings?

[ fes J[ me

Figure 6.1.4

e The Programming window should now appear as shown in Figure 5.5.5:

Search altera.com O

cvsocn pse e (7 ) e |

Enable real-time ISP to allow background programming (for MAX II and MAX V devices)
M b | File Device Checksum Usercode Program/ verify  Blank- Examine Security
Bl Start | Configure Check Bit
sy | | fsnone> | SCSXFC6D6ES oooo0000  <none> [ T N N
)| | <none> SOCVHPS 00000000 <none> OJ O O ] O

1 ]

Figure 6.1.5
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Hardware Debug Flow (System Console)

e Select the file row for the 5CSXFC6D6ES
o Select, Change File

e If you compiled the design Select the soc_system.sof, as shown in the \output_files directory
OR

Select the soc_system.sof, as shown in the .\ precompiled_files_for_system_console_module

@ Select New Programming File @
Look in: [ | ci\altera_trn\SocKIT_Materials_1..\SoCkit HW_Lab_14.t\output fles ~| @ © O 1 [3)
-~
,& My Computer Mame Size Type Date Modified
7.1MB i :
[2) 202910 || soc_system.sof sof File 2/6/20..:26 AM
Boxes

File name: soc_system,sof Qpen
Files of type: [Programming Files (*.sof *.pof *.jam *jbc *.ekp *.jic) - ] [ Cancel ]

Figure 6.1.5
e Select Open
e Select the checkbox in the program/configure column and a check will appear.

e The window should then now look as shown (If not, then delete the extra 5SCSXFCD6ES device):
% Quartus T164-Bit Programmer - [Chainl..cdf]* E@

Search altera,com @

Mode: [ITAG *]  Progress:

Ele Edt Yiew Processing JToos Window Hep 5

& Hardware Setup...| v SoCkit [USB-1)

[] Enable real-time ISP to allow background programming when available

Fie Device Chedsum  Usercode Program/ Ve
i Start. o 7

Examine Security Erase
Bit

Blank-
Check
C:/faltera_trn/SoCKIT_Ma... SCSXFCEDEF31 02A18363 02A18363
<none SOCWHPS 00000000 <none

s stop
3 Auto Detect
 Delete
(s, Add File...

¥ Change Fie...

< (T »

ek Save Fie

(% Add Device...
Thup

1% pown

SCSXFCADEF3L SOCVHPS
TDO

-~
T

Figure 6.1.6
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Hardware Debug Flow (System Console)

Press the Start Button as shown in Figure 6.1.6 to program the FPGA.

W Quartus 1 64-Bit Programmer - [Chainl.cdfT*
File Edit Miew Processing Tools Window Help )]

[E=H o )

Search altera,com @

%, Hardware Setup...| CV SoCKit [USE-1]

[ Enable real-time 15P to allow background programming when available

Moce: Progress: J

st File Device

I
b

Checksum Usercode Program/ Verify Blank- Examine Security Erase
Configure Check Bit d

&b Stop C:/faltera_trn/SoCKIT_Ma... 5CSXFCEDEF31

02A18353 02A18363

<none > SOCYHPS
3 uto Detect

H Delete

[ Add File...

E Change File...

00000000 <nene >

Fl

[ »

A save File
(% Add Device...
thup
1 Down

SOCVHPS

»

m,

Figure 6.1.6

After programming the FPGA the progress indicator should indicate 100% complete as shown in Figure 6.1.7. There should be

Nno error messages.

4 Quartus I164-Bit Programmer - [Chainl.cdf]*
Ele Edit View Processng Toos Window Help 5

[E=8 Bl 5

Search altera.com @

&, Hardware Setup....| SIETSRINEE

["] Enable real-time T5P to allow background programming when available

Mode: [1TAG =] Progress: 100% (Guccessful) |

Tyr— File Device

Cifaltera_trn/SoCKIT_Ma... SCSXFCEDEF3L

allh 5ty
" <none> SOCVHPS

$ Auto Detect
3 Delete
(M Add File...

¥ Change File...

Checksum Usercode Program/  Verify  Blank-  Examine  Security  Erase
Configure Check it

02415363 02A18363

00000000 <none>

m b

[ save File
(% Add Device...
Thup
1 Down

SOCVHPS

m
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Hardware Debug Flow (System Console)

Select File -> Exit to close the Programmer window.

Select the “No” button as shown in Figure 6.1.8 to complete closing the Programmer window.

[ &4 Quartus T ﬁ1

'soc_system.cdf has been modified. Do you want to save your changes?

l'\

Figure 6.1.8

6.2 Executing System Console Scripts

There are different ways to debug a design. Qsys was utilized to build the system and a JTAG to Avalon Master Bridge was
added to the design. As a result, debug can be completed by using System Console. System Console is a low level hardware
debug tool that is built with Tcl and runs Tcl scripts and commands.

Hardware Debug Flow (System Console)

System Console is used for low-level system debug over JTAG on any Qsys based system
® Tcl-based
Familiar development tool language
® Interactive
Opens as a separate window
Opens in Qsys or in the Nios® I Command Shell
® Scriptable
Tcl files can be “sourced”
Supports command line arguments

Supports standard input/output
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Hardware Debug Flow (System Console)

Examples of Use

® |ow-level Debug

Board bring-up and interface testing
System clock, reset, and JTAG chain validity testing

Qsys component functionality testing

® System-level Debug

Provide test vectors, return response

No processor required

For more detailed information, please download and read the System Console User Guide

A functional test of the components instantiated in the FPGA will be realized with System Console. The software lab will also
utilize system console and the ARM DS-5 tool to cross-trigger from the DS-5 to the FPGA and FPGA to DS-5.

When creating and debugging SoC based systems, the hardware Engineer will want to validate the peripherals and any Qsys IP

that has been created on the FPGA side. This IP validation will be completed in the following steps utilizing System Console.

Basic System Console Test

This diagram shows an overview of the interface from System Console to the Qsys design that includes the PIO registers

(button_pio & led_pio). A set of Tcl commands will be executed from the System Console to read from the system registers

associated with the address of the push buttons (KEY3-KEYO) and then write to the system register associated the LEDs.

Depending upon the KEYs read, this write will then illuminate the associated LED by bit position.

FPGA

System JTAG
Console

Interrupt
Capture

Int

RAW

CSR
PIO

HPS

Cortex-A9
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Hardware Debug Flow (System Console)

Figure 6.2.1

e To run System Console in Quartus Il, select: Tools -> Qsys. This will open the Qsys window.
e Select the soc_system. gsys file so that your Qsys design will open.
e In Qsys, select: Tools -> System Console.
® A new window will now appear as shown:

=
W system Console
Fie Tooks Help

o

System Explorer
v

& b conecions
® designs

i ceson_mstances
® saos

Messages
[ —

© Frished discovering JTAG connections

Figure 6.2.2

Although the Tcl commands can be executed from the Tcl Console command line, a script was created to automate

the process.

To run the script, select: File -> Execute Script. There will be a pop up window that appears that looks as follows:

SoCKit HW Lab Instructions, Version 14.1

To run the script, select: File -> Execute Script.
There will be a pop up window that appears that looks as shown in Figure 6.2.3
Scroll to the correct path where you un-archived the lab files, and select test_one.tcl.

Do not select Open yet.

o e = |
Lookin: | |, SoCKIT_HW_lab_13.1 - 2ee@a
T L qsys_edit
& ) db
Rm‘tzavs ). he_output
). hps_isw_handoff
). incremental_db
|
Deskiop ). output files
). simulation
S, L. soc_system
['\ ki top
My Documents | 2] ghrd_sc_script.tcl
2| Script_to_run.tcl
&‘ 2 soc.tcl
o ) test oneutcl
Computer
§ ~— =
NetOk  Fies of type: [0 s (ad) S
Figure 6.2.3
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Hardware Debug Flow (System Console)

o Before selecting Open, there are various push button combinations to try. The FPGA push buttons are the
buttons on the bottom right hand side of the board.

Figure 6.2.4

Hold down push button KEYO and then select Open.

You should also see the following hex numbers: 0x0e 0x00.

In the messages window, System Console test done will appear.
Release the KEYO button.

LEDO will not illuminate

Other combinations are possible when executing the test_one.tcl script:

Press KEY(s) then run test_one.tcl Result for LEDs and System Console

Hold down KEY1 and run the test_one.tcl script. | 1101 = 0x0d
Release the buttons when the words System (LED1 will not illuminate)
Console test done in the Window show up

Hold down KEY1 and KEYO at the same time and | 1100 = 0xOc

then run test_one.tcl.. (LEDO & LED1 will not illuminate)
Do not select any of the KEYs and then run 1111 = Oxof
test_one.tcl. (AIl LEDs are illuminated)

Table 6.2.1

o Close the System Console window, select: File -> Exit

If the design was compiled in Quartus and the System Console scripts were not run successfully, precompiled files can
be extracted from the "precompiled_files_for_system_console_module" directory. Copy the .jdi and .sof files to the
output_directory. Copy the .sopcinfo file to the "SoCkit_HW_lab_14.1" directory. Redo sections 6.1 and 6.2

Congratulations!
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You have just run the System Console debugging window.

6.3 Experiments with the System Console Window (Optional)

e Open the test_one.tcl file with an editor and take a look at the code.
e To perform any commands in the Tcl Console you will have to type in the following commands:

% set AvailableServices [get_service_types]
% set jtag_master [lindex [get_service_paths master] 1]
% open_service master Sjtag_master

e master_write_8 Sjtag_master 0x10040 $CurSwitch

You can change the value of SCurSwitch to be a value of 4, for example so that it now looks for
% master_write_8 Sjtag_master 0x10040 4

e This command writes a 4 (0100) to the address of the FPGAs LEDs (0x0001_0040). Therefore, only LED2 will
be illuminated. (The KEY(s) are active low, therefore; the reason for the difference when reading from the
KEY(s) address and writing to the LED(s) address.

e When you have finished close the service with the following command:
% close_service master Sjtag_master

e When you have finished close system console:
Select: File -> Exit

System Console is an extremely valuable troubleshooting/debug tool that allows you to create graphical user interfaces called
dashboards. These dashboards can interact with the Qsys IP on the device. Examples of dashboards that have been created
for debugging include the Transceiver Tool Kit, the External Memory Interface Toolkit and the ADC Toolkit for MAX10.

Congratulations!

You have just completed using System Console.
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Hardware Validation with Simulation (Do at home Exercise)

MODULE 7. Hardware Validation with Simulation (Do at home Exercise)
Module Objective:
In this module you will simulate the LED_PIO hardware in the FPGA you created in Qsys.

Simulation allows the design to be verified before it is programmed into the device. Quartus Il allows both RTL and gate level
simulation. RTL simulation is a cycle-accurate simulation and will be covered in the Module.

The RTL simulation can consist of the entire design or sub-components of the design. In this module the RTL simulation will
only include the LED PIO (Parallel Input Output) component in the system.

FPGA

R/W

PIO

l LEDs

Figure 7.1.1

The LED PIO uses Avalon signals to toggle on/off the LEDs.
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7.1 Installing ModelSim-Altera (Complete 7.1 only if you didn’t install ModelSIM in Module 1)

1. ModelSim-Altera (simulator software) is needed to be installed before this Module can be completed. ModelSim-
Altera can be downloaded from the following URL:

https://www.altera.com/download/sw/dnl-sw-index.jsp

2. Select: Select by Software under Software Selector
3. Select: ModelSIM-Altera Starter Edition
4. Select: Select Version or Product: 10.1e for Quartus Il vi4.1

5. Select: Download

Download Center
Home * Support > Downloads >

Latest Release: Quartus IT Version [14.1

Which version of the Quartus 1T software supports mv device? e —

ipti iti Related Link:
Quartus II Subscription Edition » Download

Paid license required

(-— The industry's 1 design software What's New
. in performance and productivity.
g;gﬁgs I Free 30 day trial Compare Quartus IT Web

Quartus TT Web Editi and Subscription Edition
uartus e ition -
FREE, no license required » Download Compare ModelSim-Altera

A FREE version of Quartus@Il A

software for your CPLD and and ModelSim-Altera Starter

selected medium-density and low- EifLm
cost FPGA devices.

IP available for purchase LTy S iiaT

ModelSim. § ) Altera®SDK o OpenCL”

ModelSim-Altera software Altera SDK for DI?BII_EL _
Altera's version of ModelSim software. The FPGA industry's first Software Development Kit
(5DK) for OpenCL.

\#SoCEDS ¥ | (7% DSPBuilder ¥

SoC Embedded Design Suite DSP Builder
Comprehensive and powerful software development Helps to shorten digital signal processing (DSP) design
suite for your ARM-based SoC FPGA embedded design. cycles.
Figure 7.1.2
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Hardware Validation with Simulation (Do at home Exercise)

6. Select: Individual Files

7. Select: Download Selected Files to download ModelSIM-Altera Edition (includes Starter Edition)

Combined Files ual Files Additional Software

Download and install instructions:
Read Altera Software vi4.1 Installation FAQ
Quick Start Guide

[v]Select All

[ Quartus II Subscription Edition 0

[[]Quartus II Software (includes Nios II EDS)
Size: 1.7 GBE MD5: 386032026B596993E25FAS78FDCSF744 UPDATE

eISim-AItera Edition (includes Starter Edition)
e: 1.1 GB MD5: C831A4F7FIB43060DDBER248607993C7C
[[|Devices

You must install device support for at least one device family to use the Quartus II software.

[[]Arria II device support
Size: 664.8 MB MD5: FIACD701CC473FBC5683F4A0CH372211

[‘]Arria V device support
Size: 1.3 GB MD5: 87B7D003DAFE787CEG2993E370540043

[]Arria V GZ device support
Size: 1.9 GB MD5: AGFBAB4CEY7DDERABC4BS0CC02A64DCE

[[JArria 10 device support
Size: 3.5 GB MD5: 8DC178E805F176BFD7119135B6A4B33E

[‘]Cyclone IV device support
Size: 462.7 MB MD5: 599319EBE4DDBFAOBG22505B22432E86

[‘]Cyclone V device support
Size: 1.0 GB MD5: 446D7EES999226CD3294F890A12C53CC

[[JMAX II, MAX V device support
Size: 11.3 MB MD5: C3EDC556AC9770DB2DD63706EECA2654

[JMAX 10 FPGA device support
Size: 289.0 MB MDS: 7SF2D4AF1EB47FC53AC6B619A35BD2CF

[]stratix IV device support
Size: 535.0 MB MD5: 54260F8123D9AAFASADD04DS9D223520C

[]stratix V device support
Size: 2.7 GB MD5: EVB7A4AB3E723DA0BD19CIDA2FSS9F4F

" Download Selected Files ®

Figure 7.1.3

8. Gotothe download directory and run the executable: ModelSimSetup-14.1.0.186-windows.exe
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Hardware Validation with Simulation (Do at home Exercise)

9. Select NEXT as shown in the following screenshot

€+ Installing ModelSim-Altera Edition or Starter Edition 10.3¢ (Quartus [114.1.0.186) (32-bit) = Ec( ="

Setup - ModelSim-Altera Edition or Starter Edition 10.3c (Quartus IT 14.1.0.186) (32-bit)

Welcome to the ModelSim-Altera Edition or Starter Edition 10.3c (Quartus II 14.1.0.186) (32-bit) Setup
Wizard,

For more information about Altera software, go to http:/fwww altera.com.

Figure 7.1.4

10. Select ModelSim-Altera Starter Edition, then Next

€+ Installing ModelSim-Altera Edition or Starter Edition 10.3¢ (Quartus 114.1.0.186) (32-bit) =n| Wl <
Select the ModelSim edition you like to install Alm
@

@ ModelSim-Altera Starter Edition

- License is not required.
7} ModelSim-Altera Edition

- License is required.

InstallBuilder
< Back ] [ MNext = ] [ Cancel

Figure 7.1.5
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Hardware Validation with Simulation (Do at home Exercise)

11. Select: | accept the agreement, then Next

¢ Installing ModelSim-Altera Edition or Starter Edition 10.3¢ (Quartus 114.1.0.186) (32-bit) =n =R

—
License Agreement m
®

‘fou can view the full license agreement at the link below. You must accept the terms of the agreement before continuing with the
installation.

http: {/dl.altera. com/eula

QUARTUS(R) II LICENSE AGREEMENT VERSION 14.1, ALL -
DISTRIBUTIONS (WEB DOWNLOAD, DVDS)

Copyright (C) 1991-2014 Altera(R) Corporation. All rights

reserved. "Quartus" is a registered trademark of Altera Corporation

in the U.5. and other countries. Any other trademarks and trade names

referenced here are the property of their respective owners. Certain

files, programs, or other materials provided in connection with the

Licensed Software may originate or contain components from Third Party

Licensors and are licensed to You pursuant to the terms of the o

@ I accept the agreement

Do you accept this license?
o z ) Ido not accept the agreement

[ < Back ] [ Next > ] [ Cancel
Figure 7.1.6
12. Navigate to the installation directory and select Next >
£ Installing ModelSim-Altera Edition or Starter Edition 10.3¢ (Quartus 114.1.0.186) (32-bit) ===

Installation Directory Alﬂ-;m
®

Specify the directory where ModelSim-Altera Starter Edition 14, 1.0. 186 will be installed
Installation Directory  C:\alterall4, IWE

< Back ][ Mext > ][ Cancel

Figure 7.1.7
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Hardware Validation with Simulation (Do at home Exercise)

You will only need to install ModelSim-Altera Starter, since Quartus Il was installed in a previous step.

7.2  Set EDA Tool Settings in Quartus II

Open Quartus II, select B3l -> All Programs -> Altera 14.1.0.186 Web Edition -> Quartus Il Web Edition 14.1.0.186
-> Quartus 11 14.1 (64)

1. Ifyou're design isn’t open, then to Open your design, select: File -> Open Project and select:
C:\altera_trn\SoCKit\SoCKit_HW _lab_14.1\soc_system.qpf

2. Setup Nativelink for ModelSim-Altera in Quartus Il. Select: Tools -> Options

3. Under the Category: General: select: EDA Tool Options

4. Next, select the browse button E]| and browse to your ModelSIM Installation Directory and select the path to

win32aloem

C:\altera\14.1WE\modelsim_ase\win32aloem

g; Options @
Category:
4 General EDA Tool Options
EDA Tool Options
Fonts Specify the directory that contains the tool executable for each third-party EDA tool:
Headers & Footer.s .Settings EDA Tool Directory Containing Tool Executable
4 Internet Connectivity

Motifications E]

Libraries synplify [o]
4 TP Settings §

IF Catalog Search Locations Synplify Pro E]
Design Templates Active-HDL E]
License Setup o

Riviera-PRO
Preferred Text Editor i D
Processing MadelSim D
Tooltip Settings QuestaSim D
4 Messages
Cogllors MadelSim -Alterac Ci\altera\14. IWE\modelsim_ase\win32aloem > D
Fonts
[ Use NativeLink with a Synplify/Synplify Pro node-ocked license
0K ] ’ Cancel ] [ Help
Figure 7.2.1
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Hardware Validation with Simulation (Do at home Exercise)

5. Select OK.
6. InQuartus ll, select: Assignments -> Settings

7. On the left hand side of the window, select the EDA Tool Settings -> Simulation to the following:

" Settings - soc_system EI@

Files

Libraries Spedify options for generating output files for use with other EDA tools.
4 Operating Settings and Conditions
voltage Tool name: [MudEISim-AJtEra - ]
Temperature . . 4 .
4 Compiation Process Settings [] Run gatedevel simulation automatically after compilation
Early Timing Estimate
- .
Incremental Campilation EDA Metlist Writer settings
Physical Synthesis Optimizations Format for output netiist: [Verilog HDL - ] Time scale: |1ps - ]
4 EDA Tool Settings
Design Entry/Synthesis Output directory:  simulationmodelsim
*
ST eation [] Map ilegal HOL characters [ Enable glitch filtering
Board-Level Options for Power Estimation
4 Analysis & Synthesis Settings
WHOL Input [] Generate Value Change Dump (VCD) file script  |Script Settings...
Verilog HOL Input
Default Parameters Design instance name:
Fitter Settings
TimeQuest Timing Analyzer
Assembler [More EDA Netlist Writer Settings. . ]
Design Assistant A =
SignalTap II Logic Analyzer NativeLink settings
Logic Analyzer Interface @ Mone
PowerPlay Power Analyzer Settings
SSN Analyzer () Compile test bench: Test Benches. ..

Use script to set up simulation:

() Script to compile test bench:

More Nativelink Settings...

9. Select OK.

7.3  Run RTL Simulation

1. In Quartus I, select: Processing -> Start -> Analysis and Synthesis.

2. Torun the RTL simulation, in Quartus I, select: Tools -> Run Simulation Tool -> RTL Simulation.
This step will automate the set up of ModelSim-Altera and compiling code within ModelSim-Altera.

Please disregard the errors in Modelsim

3. Once the compilation in the Transcript Window is finished, the next step is to run the simulation.
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Hardware Validation with Simulation (Do at home Exercise)

Simulate code

The signals and waveforms can be added manually or via script. A script was created, and it can be executed to automate the
simulation.

1. To run the script in ModelSIM select: Tools -> Tcl -> Execute Macro

™ ModelSim ALTERA STARTER EDITION 10.0d
File Edit View Compile Simulate Add Wave Layout Window Help
PECEFT ECCL e LT CELL

Code Coverage 3

Functional Coverage 3

Layout [WoDesign ﬂ ‘ Toggle Coverage 3

Coverage Save...

ColumnLayout |;,-_J_]_';31wma Coverage Report 2 HD H él" £ T E H E.E- E.'g E{: Eg H P % H Q Q Q Q ng%
Coverage Configuration ¥

E L ! § i ‘ Breakpoints. ..
A} Library ] Dateset Snapshnt < | Wave - Default
'1Ty'pe ‘Nama Trace [ -

Library m wark (empty) Invake 0-In View...

Library ﬂ-ﬂk hps_top _

Library m rii_work (empty) Td Execute Macro. ..

Library ﬂ—mk 220model Wildcard Filter...

Library el 220model_ver Edit Preferences...

Library ﬂ—ﬂl altera - w ]

Library ﬂ—ﬂk altera_lnsim &MODEL_TECH/.. faltera/vhdfz

Library ﬂ—ﬂk altera_Insim_ver &MODEL_TECH/.. falteraverilo:

Library ﬂ—ﬂk altera_mf SMODEL_TECH/.. falterafvhd/z

Library ﬂ—m altera_mf_ver SMODEL_TECH/.. falterafverilo

Library ﬂ-ﬂk altera_ver SMODEL_TECH/.. falteraveril:

Library ﬂ-ﬂk altgxh SMODEL_TECH/.. falterafvhdl/z

Library ﬂ-ﬂk altgxb_lib SMODEL_TECH/.. falterafvhdl/z

Library ﬂ—mk altgxb_ver SMODEL_TECH/.. [altera/verilo

Library + arriagx SMODEL_TECH/.. falterafvhdfe

Library ﬂ—ﬂl arriagx_hssi SMODEL_TECH/.. falterafvhdlfe

Library ﬂ—ﬂl arriagx_hssi_ver SMODEL_TECH/.. faltera/verilo

Library + arriagx_ver &MODEL_TECH/.. falteraverilo:

Library + arriaii SMODEL_TECH/.. falterafvhd/z

Library ﬂ—ﬂk arriaii_hssi SMODEL_TECH/.. falterafvhd/z

Library ﬂ-ﬂk arriaii_hssi_ver SMODEL_TECH/.. falteraveril:

Library ﬂ-ﬂk arriaii_pde_hip SMODEL_TECH/.. falterafvhdl/z

Library ﬂ-ﬂk arriaii_pcie_hip_ver SMODEL_TECH/.. faltera verilo j
| | |

i, Library [

1 N

2. Select: C:\altera_trn\SoCKit\SoCKit_HW_lab_14.0\Script_to_run.tcl.
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Hardware Validation with Simulation (Do at home Exercise)

3. The simulation results should now be displayed as:

M Wave - Default

T (LT —
1111 IZIl[Il 0...

4. Drag cursorl in the Wave window so that the signal names can be shown completely:

M Wave - Default

B fsoc_system_led_piofout_port
B“. fsoc_system_led_piofreaddata
B4 (soc_system_led piofaddress
£ fsoc_system_led_pio/chipselect
£ fsoc_system_led_pio/dk
4 fsoc_system_led_piojreset_n
4 fsoc_system_led_pio write_n
B£  fsoc_system_led_pio/writedata
4 fsoc_system_led_pio/ck_en
B fsoc_system_led_pio/data_out

1111 Toi01
1111 Jo101 0...

5. Select: View ->Zoom -> Zoom Full to see the entire simulation
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Hardware Validation with Simulation (Do at home Exercise)

7.4 Validate simulation

Validation of simulation is important to ensure that the results in the designs are correct. For the PIO component, there are

input and output signals. The input signals are chipselect, clk, reset_n, write_n, address[1..0], and writedata[31..0]. The

output signals are out_port[3..0] and readdata[31..0] as seen below.

hps_top_led_pio:led_pio

chipssisct

ik

rasat_n out_port[3 0]
write_n raaddata[31_ 0]
aridress[1_0]

— WiTbEEEtE[3 0]

L)

Compare the simulation waveform results to the following comments

Inputs:

vk wnN

Chipselect (soc_system_led_pio/chipselect) is set to high for the entire simulation; therefore, the led_pio component
is enabled.

Clock (soc_system_led_pio/clk) is set to toggle, since is a clock signal.

Reset_n (soc_system_led_pio/reset_n) is first initialized as 0 and then high (1) to ensure the reset is correct.

Write_n (soc_system_led_pio/write_n) is set to O since it is an inverted write signal.

Address (soc_system_led pio/address_n) is set first to 11 (to show that there is no output when the address is 11),
and then 00 (to show there is output with this address)

Writedata (soc_system_led_pio/writedata) is a 32 bit Avalon number that is written to the PIO.

Outputs:

out_port (soc_system _led_pio/out_port) is the 4 bits to the LED. The 1111 signal, which comes for the writedata,
occurs one clock cycle after the address is set to 00. The 1111 signal then changes to 0101, after one clock cycle of
the writedata. This shows that LED does toggle as expected.

Readdata (soc_system _led_pio/readdata) is the read data. This PIO does not use this signal, because the PIO is set to
be an output.

Congratulations!

You have just run a simulation.
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Taking the next Step

MODULE 8. Taking the next Step

Altera has a number of resources available to assist you in further product development at www.altera.com/embedded
Some of the resources available are:

Get more information about Qsys and SOC with online training:
http://www.altera.com/education/training/curriculum/embedded_hw/trn-embedded_hw.html|
http://www.altera.com/education/training/curriculum/embedded_sw/trn-embedded_sw.html

Get more information about Qsys:

System Design with Qsys Reference Manual
http://www.altera.com/literature/hb/qts/qsys_intro.pdf

Creating custom Qsys Components
http://www.altera.com/literature/hb/qts/qsys_components.pdf

Visit the rocketboards.org community web site
http://www.rocketboards.org/

Arrow SoCKit Evaluation Board support site
http://www.rocketboards.org/foswiki/Documentation/ArrowSoCKitEvaluationBoard

Altera SoC Development Board support site
http://www.rocketboards.org/foswiki/Documentation/AlteraSoCDevelopmentBoard

Get more information about the SoC HPS

Hard Processor System Technical Reference Manual
http://www.altera.com/literature/hb/cyclone-v/cv_5v4.pdf

Get more information about the SoC Embedded Design Tools

Embedded Software for the Cortex-A9 MPCore Processor
http://www.altera.com/devices/processor/arm/cortex-a9/software/proc-a9-embedded-software.html
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Taking the next Step

Get additional SoC training

Designing with an ARM based SoC
http://www.altera.com/education/training/courses/ISOC101

Developing Software for an ARM based SoC
http://www.altera.com/education/training/courses/ISOC102

For all resources visit www.altera.com/embedded
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